GVD 5.10 Backup User Guide

Please note, Guides will available for the latest software version, for any future releases.

We will not be maintaining older versions. Please reach out to support if you have any specific questions or to our customer success
team to upgrade your version.

Overview

GVD is GlobalVision's Desktop inspection platform.

It supports Text, Graphics, Color, Barcode, Braille, and Spelling inspections. Instructions in the User Guide are intended to describe the features
and functionalities available to general user groups with no administrative access.

) Note: This guide only covers details available on our latest GVD software version. For further details regarding functions available to
older versions please refer to the Archived Functions section.

Solution Highlights

The highlights of the solution's functions include:

Inspection Modules

Ability to identify missing, added, or modified content such as text, print defects, and color differences.
Ability to review differences and add comments and levels.

Ability to append inspection results.

Ability to generate PDF reports with comments and levels.

Ability to detect spelling errors.

Ability to inspect Braille on scanned samples (frontside and backside).

Generic Functions
® Ability to compare digital files of the following formats:
File Type Extension

The file format created by CTP (Computer to Plate) RIP. Usually, screening is A-BIT TIFF
performed and then data is separated into CMYK.

TIF is an image format file for high-quality graphics. TIF

Adobe lllustrator Artwork or Al is a file format developed by Adobe Systems for ~ .Al
representing single-page vector-based drawings in either the EPS or PDF format
S.


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2380366020/Archived+Functions
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The BMP or bitmap file format, device-independent bitmap file format and
bitmap. It is a raster graphics image file format used to store bitmap digital
images, independently of the display device.

A DOC/DOCX file is a Microsoft Word document file that typically contains text.

JPEG is used in a number of image file formats. JPEG is the most common im
age format used by digital cameras and other photographic image capture
devices.

The Portable Network Graphic (PNG) file format is ideal for digital art (flat imag
es, logos, icons, etc.), and uses 24-hit color as a foundation.

A LEN file is a bitmap file that is made by an Imaging Engine, FlexRipC.

PDF stands for "Portable Document Format". This format is used to save files t
hat cannot be modified but still need to be easily shared and printed.

The Rich Text Format is a document file format with published specification
developed by Microsoft Corporation from 1987 until 2008 for cross-platform
document interchange with Microsoft products

.BMP

.DOC/.DOCX

JPEG

.PNG

.LEN

.PDF

.RTF



TXT extension represents a text document that contains plain text in the form of . TXT
lines.

The XLSX/XLS file format is the default format to save spreadsheets without XLS/.XLSX
macros in Microsoft Excel.

XLS

The Extensible Markup Language (XML) is a simple text-based format for XML
representing structured information like documents, data, configuration, books,
transactions, invoices, and much more.

Ability to compare scanned and digital files and multi-page documents (e.g. labels, cartons, inserts, and booklets).
Ability to decode and grade barcodes.

Ability to measure and compare color points.

Ability to translate Braille in multiple languages.

Ability to compare a printed component on cylinders and tubes to an electronic file using GlobalVision's C8 scanner.



GVD 5.10 Backup Getting Started

Once GVD is installed, Administrators given the credentials can create users.

€3 Note: The Application is installed with a default administrator account. To obtain the default administrator username and password,
contact GlobalVision Support by email at support@globalvision.co or by telephone at 1-800-501-0511.

Login

To log in to the Application:

® Click the Application shortcut on your desktop. The Login window displays.

" Login

GvVD

Type in your user name, password and then dick Login

User Mame | Login

Cance

Forgot pas

Login Window

® Enter your Username and Password and click Login.

) Note: First-time login will require you to enter the default administrator username and password provided upon installation of the
application.

Change Password

To change your password:

® Click Menu Change Password.
® The Password window displays, allowing you to create a new password:


mailto:support@globalvision.co

GVD 5.10 Backup Loading Files

The first step towards an Inspection is loading a file. It can be done in two ways:

1. Upload New File
2. Load from a Scanner

Each of them is explained in detail in the following chapters:

® GVD 5.10 Backup Loading Digital Files
® GVD 5.10 Backup Loading Scanned Files
® GVD 5.10 Backup Job Wizard


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931490953/GVD+5.10+Backup+Loading+Digital+Files
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931490998/GVD+5.10+Backup+Loading+Scanned+Files
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491041/GVD+5.10+Backup+Job+Wizard
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Enter your old password in the Old Password text box.

Enter your new password in the New Password text box.

Enter your new password again in the Confirm Password text box.
Click Accept. Click OK once the notification window displays.

) Note: Only applicable for valid local user accounts. Go to Add Local User Account to learn more about local user creation and
management.

Logout/Exit

To log out of the Application:
® Click Menu Logout to save your session and return to the Login window.
To exit the Application and ensure all changes made to the system go into effect with the next log-in:

® Click the X at the top of the window.

Help

The following options are available to you upon clicking the Help icon:

Select About to get version details about the Application.

Select Shortcuts to display all keyboard shortcuts.

Select Video Tutorial to consult GlobalVision support videos on particular features.
Select Give Feedback to request new features or report bugs.

Select GlobalVision Support to link to the GlobalVision online knowledge base.
Select Licensing to display the Serial Number and Company Name.



GVD 5.10 Backup Loading Digital Files

Summary

This section covers details of how to upload a file through the Main toolbar options.

To load a file in either Master or Sample panel for inspection

® Click on the File icon on the top panel then Load Master or Load Sample to launch the file-explorer window,

Or,

® Double-click in the Master or Sample panel,
Or,

® Single-click the folder icon in the Master or Sample panel, once the load-file window is launched, choose your file and click Open.
Or,

® Use drag and drop.
® For a PDF or Al file, the PDF Options Panel appears.

@ GlobalVision

B2 @

Mew Job

Load Master (Ctrl + B

Load Sample (Ctrl + 5)



https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1256915292/PDF+Viewer

GVD 5.10 Backup Loading Scanned Files

Summary
Other than uploading a digital file, the user can directly scan a physical document. The process is comprised of the following steps.

To scan a file in either the Master or Sample panel:

® Click on the Load from Scanner icon on the top panel then Select Source.

# GlobalVision

=

A

Scan Master (Ctrl + Shift + )

Scan Sample (Ctrl + Shift + 5)

select Source

® Select the applicable scanner from the Scanner Selection window and click Select.

£ Note: Once the source is set up, the application will remember the selection for all future scans.

@ Scanner Selection

# Note: A scanner must be connected in order for the ‘scanner selection’ window to choose from.

Or,
® Click on Load from Scanner then select Scan Master to scan the Master document. Once scanned, the image will load into the Master

panel.



then,

® Click on Load from Scanner and select Scan Sample to scan the Sample document. Once scanned, the image will again load into the
Sample panel.

Action Profile

Inspect Braille Sample. ~ | | English

[ *

A2_braille.tif

Master
Wsittamucin =5

8 txprine

"'Bittamucin
Acetarminophen - 500mg

Relieves Sinus & Congestion

48 Capsules

Zzvr-pzEyie-t

vt sjo84 Bag

® Click the scanner icon in the Master or Sample panel. Both options launch the scan.

Note: The Master and Sample files must be rasterized at the same DPI value. If that is not the case, then an error message will notify
you about the discrepancy.

® |f the selected DPI of a file you are trying to load is different than the Desired DPI value in the current profile being used, a message
asking to change the DPI will appear.
® Click Yes to change the DPI to the prescribed amount or,
® No to move ahead with the value you had set.



GVD 5.10 Backup Job Wizard

Summary

The Job Wizard helps ensure all conventions within an organization are met from user to user and no one deviates from set processes. Printers
specifically can make use of the Job Wizard and Scan for Barcodes feature, which intuitively matches pre-labeled master files to barcodes on
given samples.

&) Setyour Job Master Path under Preferences before you begin.

Workflow

To create a job:

Click on the File icon on the top panel then select New Job.

Note: Enable the Show Job Interface checkbox in Preferences to launch the Job Wizard upon login/clicking Reset.

Select a Workflow

Carton

® Choose a workflow from default or custom (i.e. created by an administrator or user groups with Review Settings access) to continue.
® The Master & Sample Selection screen appears.



Master & Sambple Selection

Sample
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® Click on Scan Sample on the top-right corner to scan a hard copy or Load Sample to upload a digital file.

) Note: User can rotate the Sample file(s) if needed, by clicking the corresponding thumbnail at the bottom-right corner.

=
® Use the thumbnail (on non-scanned files) to open the Layers and Separations window.

Click the PDF Page Box drop-down list to choose from Media Box, Trim Box, or Crop Box selections to automatically crop the
file.

Set Enable overprint by checking the corresponding box.

Choose between Layers or separations or none from the Dieline drop-down.

Click the eye icon beside the layer(s) and/ or separation(s) to toggle on or off. Click OK to accept.
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Cancel

® Follow the same steps to load the Master File.

® Select the Scan for Barcodes button. The Barcode Selection window loads with a drop-down menu of the different barcodes contained
in the loaded Sample. Select or type in the assigned barcode as Job ID.

[ Barcode Sel... ? >

Barcode to be used for Job ID




Master & Sambple Selection

Sample

Hi Job ID

TN TG Product Name

Master

® Next, click on the Add from Job Path button(i.e. the folder icon beside scan and load master) to open the Job Path window. This
generates a list of matching master files containing the same string in their names or parent folders.

® Select the applicable Master for the current inspection.

® Fillin the Lot and Product Name field (if applicable). While a report is being generated, corresponding text entered to those field
appears in the Report Options window (also inside the PDF report)

® Click Next to go to Prepare Files screen, to select the die-line color on the Master, for the shape extraction process.

® Use the Marquee Selection tool to select different regions for inspection. Choose the file and select the desired region. Resize the
selection by scrolling over or clicking on its borders. Click on the tool again to reset.

® Inthe case of any multi-page file, a select page from the drop-down list directly below the Marquee Selection tool. This enables the new
page to be displayed and adjusted. Click the Next button again to navigate to the next master file, in case more than one had been
loaded.

® Click to close the Job Wizard and cancel the entire process at any stage.

® Click the Inspect button to load files in Master and Sample panels and run inspection.

) Note: The process follows the same steps as a normal inspection at this point, with the file(s) loaded in the Inspection View.

Consult the Graphics, Barcode, Braille, Text, or Spelling Inspection chapters for more information.



GVD 5.10 Backup Text

Text Inspection Mode lets you compare either left-to-right, right-to-left, or Asian copy in master and sample files. The Master and Sample can
be two different file types laid out differently or with similar layouts (revisions).

Text Inspection covers the following difference types:

Insertion

Deletion

Change

Color

Space

Hyphen

Italic

Bold

Underline
Subscript/Superscript
Line Break Space
Case

Font Type

Size

Minimum Font Point Size
Images

) Note: Text Inspection is dependent on ‘live text' to perform any inspection. A detailed description of ‘Live Text/Inspectable Text’ is
covered under Pre-Inspection Tools.

GVD 5.10 Backup Text Inspection - Step-By-Step

GVD 5.10 Backup Text Inspection - Pre-Inspection Tools (Master and Sample)
GVD 5.10 Backup Text Inspection - Actions and Profiles

GVD 5.10 Backup Text Inspection - Post Inspection Results Viewing

GVD 5.10 Backup Text Inspection - Post Inspection Tools


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491207/GVD+5.10+Backup+Text+Inspection+-+Step-By-Step
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491508
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491628/GVD+5.10+Backup+Text+Inspection+-+Actions+and+Profiles
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491666/GVD+5.10+Backup+Text+Inspection+-+Post+Inspection+Results+Viewing
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491789/GVD+5.10+Backup+Text+Inspection+-+Post+Inspection+Tools
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436385886/Text+Inspection+-+Pre-Inspection+Tools+Master+and+Sample#Show-Inspectable%2FLive-Text-Tool

GVD 5.10 Backup Text Inspection - Step-By-Step

Summary

This section describes the steps to follow while running a text inspection.
® Steps
Step 1. Load Files for Text Inspection
Step 2: Select Profile
Step 3: Ensure proper Inspection Area is selected using the Pre-Inspection Tools
Step 4: Run the Inspection
Step 5: View the Results
Step 6: Go through differences to assign levels or comments
Step 7: Modifying/Resetting Inspection Results
Step 8: Generate the Report

Steps

Step 1. Load Files for Text Inspection

To inspect Text:

® Click on the File Menu icon on the top panel then Load Master or click on the Master panel to select the file to load. The Master image
loads in the Master panel.

=

A

Mew lob

Load Master (Ctrl + M)

Load Sample (Ctrl + 5)

® Click again on the File Menu icon on the top panel then Load Sample or click on the Sample panel to start repeating the process to load
sample files.

Step 2: Select Profile

® Click the Profile drop-down menu to access the Application's library of available text inspection profiles.

'Hne following default profiles are installed with the system:

Profile

Default

Default

QRD

Tesxt to Artwork

Manage

Step 3: Ensure proper Inspection Area is selected using the Pre-Inspection Tools

Step 4: Run the Inspection

® Click Inspect
® The files are inspected and the differences display in the Inspection View.


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491508
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Step 5: View the Results

To view the inspected file:

® To review the difference list navigate through them using either keyboard arrows or by clicking on each difference.
® Use the trackwheel to zoom in or out.
® Hold the left mouse button and move it around to pan the image.

Step 6: Go through differences to assign levels or comments

Step 7: Modifying/Resetting Inspection Results

Step 8: Generate the Report

® Click the Report icon.

® See the Generating Reports section for step-by-step instructions.


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931491666/GVD+5.10+Backup+Text+Inspection+-+Post+Inspection+Results+Viewing
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/2213183557/Modifying+Resetting+Inspection
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931493515/GVD+5.10+Backup+Report+Generation
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GVD 5.10 Backup Text Inspection - Pre-Inspection Tools (Master and Sample)

Summary

This section describes the Pre-inspection tools needed before running Text inspection.
® Pre-Inspection Tools
® Live Text
Cross-Out Text Tool
Underline Text Tool
Create Zones
Clear Markups

) Note: The tools in this section are only available for Text Inspection.

Pre-Inspection Tools

Live Text

The ‘live text’ tool shows all live text (in Text or Spelling Inspection modules) in the Master or Sample panel:
To show live text:

® Click on the corresponding Live Text icon.
To remove live text:

® Click the icon again.

) Note: Text that is not live can still be inspected as part of a pixel-to-pixel comparison between two similarly laid-out files in Graphics
Inspection.

Cross-Out Text Tool

Cross-out allows you to cross out a text to be excluded in the inspection. The text is crossed out in red.
To cross-out Text:

® Click the Cross-out Text icon in either the Master or Sample panel.
® Click and drag the crosshair icon that appears as the cursor, over the text, to be excluded in either the Master or Sample panel. Multiple
selections can be made simultaneously.

To apply a cross-out to different portions of a multi-page file:

® Right-click on the crossed-out text.
® In the “Context” menu that appears, select to apply the cross-out to all pages, odd pages, even pages, or identical text elsewhere in the
file.



Apply to this page

Apply to all pages

Apply to odd pages

Teliaves Sinus & Apply to even pages
Cross-out identical text
48 Capsules Clear

Clear All

® Clear removes cross-outs that are selected, Clear All removes all cross-outs.
To cancel out Cross-out text using Underline Text:

® Click on Underline Text.
® Click and drag the crosshair icon that appears as the cursor over the crossed-out text.
® The cross-outs are removed.

# Note: Cross-out Text and Underline Text cannot be applied together in the same file unless it is to cancel out the other.

Underline Text Tool

Underline Text lets you select text to be included in the inspection.
To underline a Text:

® Click Underline Text on the selection toolbar and then click and drag the cursor to select the desired text. The text is underlined in green.
To apply underline text to different portions of a multi-page file:

® Right-click on underline text.

® In the “Context” menu that appears, select to apply the cross-out to all pages, odd pages, even pages, or identical text elsewhere in the
file.

® Clear removes underlined text that is selected, Clear All removes all underlined text.

Create Zones

Create Zones can be used to perform partial or targeted inspections. The user can specifically include sections of a given document in Text inspe
ctions (excluding all other text) and compare them directly to the corresponding portions in the other panel.

To create a Zone:

® Click the Create Zones icon.
® Click and drag the crosshair icon that appears as the cursor over the text to be included. The text is highlighted and an ID is assigned.
You can initiate a zone on the Master file only.



® Highlight the corresponding text in the Sample. A corresponding ID is assigned.

#) Note: The Zoning sub-panel pops up in the Sample panel as a guide for which matches are available. Clicking on a match zooms in on
that selection.

® Create new zones by clicking and dragging separate portions of text in each panel and repeating the overall process.
To add to an existing zone:

® Right-click on a zone that has already been selected, prompting the “Context” menu to appear. Select Add.
® Click and drag the cursor over a new portion of text. The same number designation of the original zone should appear at the top of the
new selection. Repeat the process in the other panel if necessary.

Bittamucir,

Acslaoghar STk,

To clear a zone:

® Right-click on a zone that has already been selected, prompting the “Context” menu to appear.
® Select Clear to delete a zone on either panel and Clear All to delete all zones in both panels.

) Note: Clear also deletes the original zone if you had right-clicked on an added portion.

Clear Markups

Clear All

Clear Master (Ctrl + Shift + X

Clear 5ample (Ctrl + Shift + Y}

To clear all underlines, cross-outs, or zones:

Click the Clear Markups icon.

Select which file to clear; Master, Sample, or all.

A message appears, asking if you want to continue.
Click Yes.

Note: OCR tool has been removed for Text Inspection in GVD version 5.9.0 and above. Please refer to our Archived Functions section
for details regarding this tool.
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GVD 5.10 Backup Text Inspection - Actions and Profiles

Actions

Summary:
Actions dictate the type of inspection that is run, as requirements vary from use case to use case. Actions can be easily selected by all users via
the Action drop-down list at the top of the user interface.

Inspection Action Description/ File Types

Compare (All Pages) Compare all pages in the Master panel to all pages in the Sample

Text Inspection
panel.

Profiles

Summary

Different inspection algorithms are used depending on the selected profile, which should be set based on the type of files inspected. Each profile
has parameters that alter the way the inspection algorithm perceives and reports differences. Therefore, it is important the correct profile be

selected for the best results.
The Application is installed with the default profiles listed in the table below, each featuring default parameter values. Administrators (or user

groups with Manage profiles access) can add, rename, and delete profiles.

ﬂ)wever, Default profiles cannot be renamed or deleted, only Custom profiles can.

Description/ File Types

Inspection Profile
Text Inspection Default Compare live text content for both different layouts and same layouts
documents. A string of words on the Master will only be matched and
compared with one element on the Sample.
QRD Compare a master document formatted as a QRD template with a
sample document.
Text to Artwork Compare the text content of a line by line format document to an

Artwork. A string of words on the Master can be matched and
compared to multiple ones on the Sample.

Examples

Text to artwork
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GVD 5.10 Backup Text Inspection - Post Inspection Results Viewing

Summary

This section describes the post-inspection results viewing process and steps, needed after running any text inspection.
® Post Inspection Results
® Difference List
® Image Details Panel

Post Inspection Results

Difference List

The Difference List displays the differences between the Master and Sample files for easy reviewing and proofing. The column headings include
the Filter Differences icon, ID, Page, Type, Master (the difference as it appears in the Master), Sample (the difference as it appears in the

Sample), Comment, and Level.

With the exception of the Filter Differences icon, click any heading to sort the list based on the contents of that column. By default, the list is
sorted by the Difference ID.

C¥

Mlaster Sample Comment Lewel

Comparator Comparater “Comparates” should be "Comparsto

To select a difference:

® Click on the difference in the Difference List. It gets highlighted in the Inspection View and displays in the Change Grid below the two
panels. The characters in yellow in the Change Grid represent the differences between the Master and Sample panels.

€ Note: Hover on any character in the Change Grid to display its Unicode value and name.

€ To group duplicated differences, Select the Group Duplicates option on the Top-left of the Differences panel.

To assign a level to a difference:

® Select the difference in the Difference List. Click the Level drop-down box and select the level.

) Note: Hotkeys (F1 — F5) may be applied to assign levels. Select the difference and click the appropriate "F" key (see below):

1 Key Function
2 F1 Reporting level - Critical
3 F2 Reporting level - Major

4 F3 Reporting level - Minor



5 F4 Reporting level - Ignore
6 F5 Reporting level — None

To assign a level to multiple differences:

* Hold down CTRL while selecting the differences, click the Level column in one of the selected rows, and select the level.
Mone
Mone
Critical
Major
Minor

Ignore

) Note: On a Mac OS, to assign a level to multiple differences, hold down the COMMAND and SHIFT keys while selecting the differences,
click the Level column, and select the level.

To remove a level assighment:
® Click the Level column and select None. The level no longer displays in the Difference List.

To assign a comment to a difference:

Comment

Maone

System Com rrn':nt:‘-k
orm

Barcode

® Select the difference in the Difference List. Click the Comment column and select one of the predefined comments that appear. The
selected comment displays. Descriptors (or system comments) appear as the default for Change, Size, Font Type, Bold, Italic, Hyphen
, Underline, Color, Line Break Space, and Sub/Super-type differences.

) Note: Select System Comments in the drop-down to reset the default comment for that specific difference.

To assign a comment to multiple differences:
® Hold down the CTRL key while selecting the differences, click the Comment column, and select the comment.
) Note: OnaMac OS, to assign a comment to multiple differences, hold down the COMMAND and SHIFT keys while selecting the
differences, click the Comment column, and select the comment.

To assign a customized comment to a difference:

® Select the difference in the Difference List, click the Comment column, select Freeform, and type in the Comments text box in the Diff
erence window that appears. Click OK for it to take effect.



Difference Details

Repeat 1 Difference 1

Comments

To delete a comment from a difference:
® Click in the Comment column in the Difference List and select None.
To exclude a difference:

® Select the difference in the Difference List and click F12.

) Note: An administrator or user groups with Review settings access, can configure the Application to force the inclusion of all differences,
in which case clicking F12 does not have an effect.

To filter Differences:

® Click the Filter Differences icon.
® Ensure the difference types desired to appear in the Difference List are checked by either checking/unchecking them individually, clicking
Select/deselect all.

This will toggle all difference types on or off, or clicking Defaults, which resets the selections.

® Click Filter to return to the filtered Difference List and see the desired difference types or click Cancel to disregard the selections and
close the window.

) Note: Differences excluded from the Difference List via the Filter function still appear in the generated report.

Image Details Panel

The Image Details panel displays image differences during text inspections. Switching between displayed differences is as simple as clicking on
a new image difference in the Difference List.

To assign comments and levels to an image difference, follow the same processes outlined for other difference types.

Image Details

Difference 31

Comment

"htrnl" should be "HTML" as in the or

“should be ",



) Note: Image differences only display when the Images difference type and the Include Images comparison option are checked on in the
selected profile. None of the default Text Inspection profiles have either option checked. Only administrators and managers or user
groups with ‘modify profile’ access, can create new profiles with these options turned on. For more information, consult the

Administration Guide.

To switch between displayed differences:
® Click on a new image difference in the Difference List.
To assign comments and levels to an image difference:
® Follow the same processes outlined for differences of other types.

Note: Image differences only display when the Images difference type and the Include Images comparison option are toggled on in
the selected profile.

Text Inspection profiles have neither option checked. Only administrators, managers, or user groups with ‘modify profile’ access, can
create new profiles with these options turned on.



GVD 5.10 Backup Text Inspection - Post Inspection Tools

Summary

This section describes the Post-inspection tools needed to inspect any file after running a text inspection.
® Post Inspection Tools
® Resync
® Show/Hide

Post Inspection Tools

Resync

-

=

Click the Resync Tool icon to remove an undesired difference that is an identical match between the Master and Sample from the inspection
results.

To resync a difference:

® Click the Underline Text icon underneath the Master panel and click and drag the crosshairs to select the difference in question. The
text gets underlined in blue.

Alternatively,
® Right-click on the difference in the Difference List and choose Select on master in the menu that pops up. The text in question gets

underlined in blue.

) Note: If there is a match on the Sample, it shows up in the Resync panel that appears. Clicking a match zooms in on that selection on
the Sample to be highlighted.

® Repeat either process for the Sample panel to highlight the same text.
® Click the Resync Text icon. The difference is removed from the Difference List and the number of differences detected is re-numbered.

) Note: If the differences are not identical, the difference type gets reclassified as Change and does not get removed; A resynched
difference can also not be undone. The inspection must be rerun to get it back.

To clear a selection:

® Right-click on the text underlined in blue.
® Select either Clear, to clear the underline from the word, or Clear All, to clear all underlines, in the menu that pops up.

Show/Hide

To toggle the appearance of all underlines, cross-outs, or zones on or off in a master or sample file, either before an inspection or after:

® Click the Show/Hide icon.



GVD 5.10 Backup Graphics

) Graphics Inspection lets you compare single or multi-page master and sample files pixel by pixel and detect differences in text, artwork,
etc.

Differences are highlighted and levels and comments on each can be added for a more in-depth proofing and reviewing process.

GVD 5.10 Backup Graphics Inspection - Step-By-Step

GVD 5.10 Backup Graphics Inspection - Pre Inspection Tools

GVD 5.10 Backup Graphics Inspection - Actions and Profiles

GVD 5.10 Backup Customizing Graphics Profile

GVD 5.10 Backup Graphics Inspection - Post-Inspection Results Viewing
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GVD 5.10 Backup Graphics Inspection - Step-By-Step

Summary

This section describes the steps to follow when running a graphics inspection.
® Steps

Step 1: Load Electronic Files

Step 2: Load Scanned Files

Step 3: Ensure proper Inspection Area is selected using the Pre-Inspection Tools

Step 4: Select an Action

Step 5: Select Profile

Step 6: Run the Inspection

Step 7: View the Results

Step 8: Go through differences to assign levels and comments

Step 9: Modifying/Resetting Inspection Results

Step 10: Generate the Report

Steps

Step 1: Load Electronic Files

) Note: Users can skip to Step 2 in case of Loading Scanned Files.

# GlobalVision

a
Mew Job

Load Master (Ctrl + M)

Load Sample (Ctrl + 5]

For Single-Page Inspections:

® Click the File Menu icon on the top panel then click Load Master or click in the Master panel to launch the load-file window. Select the
Master file from the load-file window and click Open.

Or,
® You can also load a file by using "drag and drop."
® |f the Master is either BMP, PNG, TIF, TIFF, JPG, or LEN file, the image loads in the Master panel.
® |f the Master is a PDF or Al file:
® Prepare the Master image(if required, using integrated PDF Options tools) to hide layers and/or separations, use shapes as
regions for repeat detection, etc.
then,

® Again click the File Menu icon on the top panel then click Load Sample or click in the Sample panel to start repeating the process to
load the Sample file.

For Multi-Page Inspections:

® Click the File Menu icon on the top panel then click Load Master or click in the Master panel to launch the load-file window. Select the
Master file from the load-file window and click Open.

® You can also load a file by using "drag and drop."



&) The first page of the Master image loads in the Master panel. The others can be selected from the Page Navigation drop-down list at the
bottom of the panel.

® |f the Master is a PDF or Al file:
® Prepare the Master image(if required, using PDF Options tools) to hide die lines, layers, and/ or separations, use shapes as
regions for repeat detection, etc.

then,

® Again click the File Menu icon on the top panel then click Load Sample or click in the Sample panel to start repeating the process to
load the Sample file(s).

For Multi-Files Inspections:

® Click the File Menu icon on the top panel then click Load Master or click in the Master panel to launch the load-file window. Select the
Master file from the load-file window and click Open.

® You can also load a file by using "drag and drop."
® Repeat the same file upload process again, on top of the first file, to add a new master file.

B Observe the Page numbers being increased as files keep getting added after the other.

then,

® Again click the File Menu icon on the top panel then click Load Sample or click in the Sample panel to start repeating the process to
load the Sample file.
® Repeat the same process for Samples to add Multiple Sample files for your inspection.

Step 2: Load Scanned Files

) Note: Users can skip Step 2 if Electronic File is being loaded.

@ GlobalVision

==

F |

Scan Master (Ctrl + Shift + M)

Select Source

® Click Load from Scanner then Select Source.



ffi Scanner Selection

® Select the applicable scanner from the Scanner Selection window and click Select.

® Click Load from Scanner then Scan Master to scan the Master document. Once scanned the image loads in the Master panel.

then,

® Click Load from Scanner then Scan Sample to scan the Sample document. Once scanned the image loads in the Sample panel.
Step 3: Ensure proper Inspection Areais selected using the Pre-Inspection Tools

Step 4: Select an Action
Action

Single Page
Single Page

All Pages

All Pages Unsorted
Single to Many

Many to Many
To compare a single master page to a single sample page or press sheet:
) Note: Only the displayed page on the Master and Sample panel would be inspected.

® Set Action then Single Page.
To compare all master pages or files to all sample pages or files:

® Set Action then All Pages.
) Note: The pages must be in order to allow for comparison. Repeats per page are not supported.

To compare all master pages or files to all sample pages or files when they are in a different order:
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® Set Action then All Pages Unsorted.

) Note: Repeats per page are not supported.

To compare a single-page master file to a multi-page sample file with repeats:

® Set Action then Single to Many.

) Note: This is useful for comparing a batch of press sheets against the Master or checking the number of instances the Master appears
on the Sample side.

To compare unsorted multi-page master files to unsorted multi-page sample files with repeats:

® Set Action then Many to Many.

) Note: This is useful for comparing batches and for gang sheets. This action requires the most memory.

Step 5: Select Profile

Profile

Digital to Scan
Digital

Digital to Scan

Len
Proof

Scan to Scan

® Click on Profile. Select the profile from the drop-down menu, that best suits your inspection needs to detect the required differences.
There is also an option to create custom profiles, check our Administration Guide for more details.

The following default profiles are installed with the system:

1 Profile File Types (Master and Sample)

2 Digital Electronic original artwork and a revised copy

3 Digital to Scan Electronic original artwork and a scanned image

4 Len Run Length Encoding bitmap file and a Run Length Encoding bitmap file
5 Proof Electronic original artwork and a digital proof

6 Scanto Scan Scanned image and a scanned image

£ Note: Please visit the Profile Settings to understand the process of adding. deleting or modifying a Profile.

Step 6: Run the Inspection

® Click on Inspect. The images are inspected and the differences display in the Inspection View panel.

Step 7: View the Results


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/edit-v2/1484030028

Sample_Cosmetic_Carton.pdf

To view the inspected image or file:

* To review the difference list navigate through them using either keyboard arrows or by clicking on each difference. Use the trackwheel to
zoom in or out of the Master or Sample panels.

® Hold the left mouse button and move it around to pan the image.

® To review multiple pages, navigate through the pages using the Page Navigation drop-down list at the bottom left of either panel.

To view a repeat:

® Click the desired repeat in the Repeats found under the layout panel or your left. Repeats with differences are highlighted in red.
Repeats without differences are highlighted in green.




.epeats found: 1

@ FRepeat E.

Step 8: Go through differences to assign levels and comments

Step 9: Modifying/Resetting Inspection Results

Step 10: Generate the Report
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f# Report Options 4

Product 1D

Product Mame

Inspected By

Indude:
Signature field Master
Only pages/repeats with differences " Thumbnails
Report Path ‘Wsers\noujaim\Documents
Report Fle M

PDF Attachment

Cormmenits

View Save Cancel

® Click the Report icon.



GVD 5.10 Backup Graphics Inspection - Pre Inspection Tools

Summary

This section describes the Pre-inspection tools needed to inspect any file before running a graphics inspection.
® Pre-Inspection Tools
® Lasso Selection
Measurement Tools
Region Mode
Crop to Contents
Match scale
Clear
Manual Alignment
Color Picker
Crop Sample
Support Rotated Repeats

Pre-Inspection Tools

Lasso Selection

Eﬂ‘
Lasso Selection allows users to outline and select specific portions of the Master file which can either be included or excluded during a graphics
inspection (shapes).

In order to add a portion of the Master to be inspected, using the Lasso Selection tool:

® Click the Lasso Selection icon to access the drop-down option. Select Add to inspection.
® Click on any point on the Master for the red dot to appear. This denotes the starting point. Now, drag and click and repeat again until you
form the first segment. Once a segment is completed a yellow dot appears.

£ Note: To undo the last segment, click on the yellow dot and re-drag the segment.

® Repeat this process until the last line connects to the very first point and the shape contains the portion of the Master which can be now
included in the inspection. Add, any additional separate portions of the Master in the same inspection (if required). The inspection when
run, will only verify the selected shape(s).

# Note: Red Dot to Signify Created Point; Dot to Signify Created Segment that Can Be Undone.

In order to remove a portion of the Master to be inspected, using the Lasso Selection:

® Click the Lasso Selection icon to access the drop-down option. Select Remove from inspection.
® Click on any point on the Master for the red dot to appear. This denotes the starting point. Now, drag and click and repeat again until you
form the first segment. Once a segment is completed a yellow dot appears.

£ Note: To undo the last segment, click on the yellow dot and re-drag the segment.

® Repeat this process until the last line connects to the very first point and the shape contains the portion of the Master which can be now
excluded from the inspection. Add, any additional separate portions of the Master in the same inspection (if required). The inspection
when run, will only verify the selected shape(s).

) Note: If a separate shape has been selected (i.e., a dieline) via Region Mode or the PDF Viewer and the lasso-selected shape(s)
appear within, the dieline and all of its contents, excluding any portions that have been lasso-selected, will be inspected.

In order to remove Lasso Selection:

® Right-click on the created shape. Select Reset to full page from the "Context" menu that launches.
® Re-select the die line if necessary.

Measurement Tools



&

]

The Measurement Tools icon gives users access to both Rectangle and Line options when running a graphics inspection. By clicking and
dragging the mouse on the file after making a selection, the user draws either a rectangle or line, with units displayed in either inches,
millimeters, or pixels. This allows user to measure the size of graphic elements in the loaded file.

To measure a Line:

® Click the Measurement Tools icon and select Line.
® Click and drag the mouse on the file in the Sample panel in the desired location. Resize it by clicking on either one of its ends and then
dragging.
® Move the line by clicking on any other portion of the figure and then dragging.
® When the cursor appears as a hand, you can move the line outright.
® When the cursor appears as a vertical double-sided arrow, you can shift its angle.
® Right-click for the option to delete the line.

Rectangle

Line

To measure a Rectangle:

® Click the Measurement Tools icon and select Rectangle.

® Click and drag the mouse on the file in the Sample panel in the desired location. Resize it by clicking on its borders and then dragging.

® Move the rectangle by clicking on its borders and then dragging. Right-click to either delete the rectangle or select Snap to the line for a
closer crop.

To generate a PDF report of the measurements (without inspecting the files):

® Click the Measurement Tools icon and select Report. When the Report Options window launches, fill in the fields as required.

# Note: The PDF Attachment option is not available for Measurement Tools reports.

® Click View or Save to generate the report, which lists each of the measurements made in inches, millimeters, and pixels.

Region Mode

Region Mode lets you select an area in the image to be inspected.

) Note: The minimum cropping area is 100 x 100 pixels.

In order to select an area in the Master image to be used in the inspection:

® Click Region Mode and select one of the options:
® Crop: Left click and use the crosshairs to create the area to be inspected. A red box will appear surrounding the selected area.
® Trim: The largest bounding area of the image is selected. A red box will appear surrounding the selected area.
® Shape: Shape mode is used to detect a shape for repeat detection. Left-click on the shape to be used as the inspection area.
The selected shape displays in the Master panel.

) Note: You can also create a shape for repeat detection with the Crop tool, by creating the shape and clicking Crop to Contents
afterward.



€3 If you right-click on a layer (e.g. dieline) and choose Set as shape region & hide or Use as shape region in the integrated PDF Viewer,
it automatically gets set as the Shape. Selecting the shape is key when inspecting repeats.

For Crop and trim selections, additional options exist in the "Context" menu that appears by right-clicking:

® Choose between applying the selection to all, even, or odd pages in a multi-page file.
® Click Change to circle to replace the rectangular selection with a circular one.
® Click Clear all pages to remove the selection.
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— Change to circle

Crop to Contents

To tighten the crop selection so that it includes only the object:



® Click Region Mode and select Crop. Select an area using the crosshairs by click and drag. A red box will appear surrounding the

selected area.
® Click Crop to Contents.

) Note: The crop selection adjusts so that it contains only the revised selection.

Match scale

Match Scale lets you compare images with different sizes by scaling the dimensions of the Sample’s cropped area to match the dimensions of
the Master’s cropped area.

To use Match Scale:

® Crop the desired area in both Master and Sample panels
® Click Match Scale. When the inspection is run, the Sample cropped area is inspected as if it were the same size as the Master cropped

area.

) Note: Both the Master and Sample images must be cropped before Match Scale is used.

Clear

Clear All

Clear Master

Clear Sample

Click the Clear button

Select Clear All to remove markups on both Master and Sample files
Select Clear Master to remove markups on the Master file

Select Clear Sample to remove markups on the Sample files



Manual Alignment

&

The Manual Alignment tool is used to align a selected point on the master image with a selected point on the sample image.

It is used to prep the loaded images for a pixel-by-pixel comparison using a selected reference point on both files uploaded. It tells the software to
overlay the Master and Sample files using the set point of reference.

To use manual alignment:
Click Manual Alignment
Set a point of reference using the crosshair on the master file

Set the same point of reference on the sample file

[ ]
[ ]
[ ]
® Inspect

Color Picker

/
To display the RGB, CMYK, and LAB color-space information for a selected area in the Master or Sample image:

® Click the Color Picker.
® Click an area in the image. The Color Picker window displays the LAB, CMYK, and RGB color-space values of the point selected.

Crop Sample

To select an area of the Sample image to be inspected:

® Click Crop. Left-click and select an area using the crosshairs that appear. A red dotted line surrounds the selected area.
# Note: The minimum cropping area is 100 X 100 pixels.

Additional options exist in the "Context" menu that appears by right-clicking:

® Choose between applying the selection to all, even, or odd pages in a multi-page file.
® Click Change to circle to replace the rectangular selection with a circular one.
® Click Clear all pages to remove the selection.
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Change to circle

Support Rotated Repeats

To run an inspection using a sample image that contains rotated repeats of the Master:

® Click Support Rotated Repeats before running the inspection. During the inspection, the images are compared without considering
rotation.

#) Note: Enabling this option will increase Inspection time significantly.



GVD 5.10 Backup Graphics Inspection - Actions and Profiles

Summary

This section describes the default actions and profile associated with Graphics inspection.

Default Actions

Inspection

Graphics Inspection

Default Profiles

Inspection

Graphics Inspection

Action
Single Page

All Pages

All Pages Unsorted

Single to Many

Many to Many

Profile
Digital
Digital to Scan
Len
Proof

Scan to Scan

Description/ File Types
Compare a single master page to a single sample page or press sheet.

Compare all master pages or files to all sample pages or files. It will
necessarily compare Master page 1 with Sample page 1 and so on.

Compare all master pages or files to all sample pages or files when
they are in a different order. It will find and compare the corresponding
page even not necessarily in the same order.

Compare a single-page master file to a multi-page sample file with
repeats.

Compare unsorted multi-page master files to unsorted multi-page
sample files with repeats.

Description/ File Types
Compare electronic original artwork and a revised copy.
Compare electronic original artwork and a scanned image.
Compare two Run Length Encoding bitmap files.
Compare electronic original artwork and a digital proof.

Compare two scanned images.

) Note: Please visit the Profile Settings to understand the process of adding. deleting or modifying a Profile.
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GVD 5.10 Backup Customizing Graphics Profile

Summary

Before performing an inspection, the action and profile for the Graphics Inspection Mode must be set.
® 1. Adding Profiles

. Repeat Detection

. Pixel Shift and Kerning

. Minimum Pixel Size

. Adjusting Sensitivity

. CTRL + D Function

. Difference Grouping

e o 0o 0 0o o
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1. Adding Profiles

To create a profile from scratch:

® Select Profile Manage. Click Add. The Edit Profile window will display pre-populated (default) values.
® Enter the new profile name in the Profile Name text box. Update the values as required.
® Click Apply. The Profile window will display, featuring the new profile name

2. Repeat Detection

® Select Profile Manage and choose a profile.
® Click the Repeat Detection tab in Edit Graphics Profile Window. Enter the custom parameters.

3. Pixel Shift and Kerning

® Select Profile Manage and choose a profile.
® Click the Text tab in Edit Graphics Profile Window. Enter the custom parameters in Low or Hight contrast.

4. Minimum Pixel Size

® Select Profile Manage and choose a profile.
® Click the Text tab or Artwork in Edit Graphics Profile Window. Enter the custom parameters in the Minimum detection size.

5. Adjusting Sensitivity

® Select Profile Manage and choose a profile.
® Click the Text tab or Artwork tab in Edit Graphics Profile Window. Enter the custom parameters in Sensitivity.

6. CTRL + D Function

Use CTRL + D Function (developer mode) to identify wish parameter to Adjust

7. Difference Grouping

® Select Profile Manage and choose a profile.
® Click General in Edit Graphics Profile Window. Enter the custom parameters in Difference grouping in pixels.



GVD 5.10 Backup Graphics Inspection - Post-Inspection Results Viewing

Summary
This section covers the results viewing process.

® Post Inspection Result Viewing
® Difference List

Add Show Mask

Overview Panel

Repeats Found Panel

Master Panel

Post Inspection Result Viewing

Difference List

The Difference List displays the differences between the Master and Sample files for easy reviewing and proofing. The column headings include
the ID, Type, and Level.

To select a difference:

® Click on the difference in the Difference List. It gets highlighted in the Inspection View and outlined in red in the Overview panel. A

checkmark 4 gets added to the Difference List to indicate it has been reviewed.
® Alternatively, use the up and down arrows to navigate through differences found.

To assign a level to a difference:

® Select the difference in the Difference List. Click the Level drop-down list in the Difference Details panel and select the level. The
color-coded level displays to the right of the difference in the Difference List.

Alternatively,

® Double-click the difference in the Inspection View. The Difference Found window displays. Click the Level drop-down list in the
Difference window and select the level. Click X to close the Difference window. The color-coded level displays to the right of the
difference in the Difference List.

) Note: Hotkeys (F1 — F5) may be applied to assign levels. Select the difference and click the appropriate "F" key (see below):

1 Key Function

2 F1 Reporting level - Critical
3 F2 Reporting level - Major
4 F3 Reporting level - Minor
5 F4 Reporting level - Ignore

6 F5 Reporting level — None
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Difference Details

Repeat 2 Difference 3

To assign a level to multiple differences:

® Hold down the CTRL key while selecting the differences.
® Click the Level column in the Difference List or the Level drop-down list in the Difference Details panel, and select the level.

) Note: On a Mac operating system, to assign a level to multiple differences, hold down the COMMAND and SHIFT keys while selecting
the differences.

To remove a level assignment:
® Click the Level column and select None. The level no longer displays in the Difference List.

To assign a pre-defined comment to a difference:

Difference Details

Repeat 1 Difference 1

Cornmenits

® Select the difference in the Difference List. Click the Comments drop-list in the Difference Details panel and select the comment. The
comment displays in the Comments text box. A sticky-note icon displays in the Difference List to the right of the difference.

Alternatively,

® Double-click the difference in the Inspection View. The Difference window displays. Click the Comments drop-down list in the
Difference window and select the comment. Click X to close the window. The comment displays in the Comments text box. A sticky-note
icon displays in the Difference List to the right of the difference.

To assign a comment to multiple differences:

® Hold down the CTRL key while selecting the differences, click the Comments drop-down list, and select the comment.



) Note: On a Mac operating system, to assign a comment to multiple differences, hold down the COMMAND and SHIFT keys while
selecting the differences, click the Comments drop-down box, and select the comment.
To assign a customized comment to a difference:

® Select the difference in the Difference List, click the Comments drop-down list in the Difference Details panel, and type in the
comment. A sticky-note icon displays in the Difference List to the right of the difference.

Alternatively,

® Double-click the difference in the Inspection View. The Difference window displays. Click in the Comments text box in the Difference
window and type in the comment. Click X to close the Difference window. The comment displays in the Comments text box. A sticky-note
icon displays in the Difference List to the right of the difference.

To delete a comment from a difference:

® Click in the Comments drop-down box in the Difference Details panel and select the blank entry.

) Note: Include difference only needed if the difference was excluded first by accident.
To include the selected difference in the report:

® Press F11

® Click Include in the Difference Details panel

To exclude the selected difference in the report, add a difference or group differences:

ST
T

Group (Shift + Left click)
Add (Shift + &lt + Left click)
Exclude (Alt + Left click)

® Exclude
® Click the Difference Review Actions icon and then Exclude.
® Use the crosshair that appears to select the difference in the Inspection View Sample panel to be excluded by left-clicking and
drawing a red box around it. The difference gets crossed out in the Difference List and excluded in the report.
® To add a difference:
® Click the Difference Review Actions icon and then Add.
® Use the crosshair that appears to select the area in the Inspection View to be added as a difference by left-clicking and drawing
a red box around it. The selected area gets added as the final difference in the Difference List.
® To group differences:
®* The Difference Review Actions drop-down list lets the user manage the differences detected, by grouping/excluding them or
adding new ones.
® Click the Difference Review Actions icon and then Group.
® Use the crosshair that appears to select the differences to be grouped by left-clicking and drawing a red box around
them. A difference ID gets assigned to the group, which is added to the Difference List as a change. The difference
count also adjusts accordingly.

) Note: You can alternatively select the difference in the Difference List and click Exclude. However, a user with administrator rights can
configure the Application to force the inclusion of all differences, in which case the Exclude and Include options do not display in the Diff
erence Details panel.

® For repeats, once you select the difference to be excluded as a difference, a message displays:

) Note: The new difference is automatically included in the report. To exclude it, click Exclude.
® For repeats, once you select to group the differences, the following message displays: "Apply to all repeats?"
® Click Yes to add the grouping to all repeats. Click No to add the grouping to the selected repeat only.
There are several ways to view differences:

® Click on the '+' sign, beside the Image to display to increase the Flash rate.



® Click on the '-' sign, beside the Image to display to decrease the Flash rate.
® Click on Image to display the drop-down menu.
® Click Flash to alternately display the differences between the Master and Sample images. To change the rate at which the
images alternate:
Click Master to display the Master image.
Click Sample to display the Sample image.
Click Difference to display the Difference image.
Click Edge to display the Edge Difference image.

Flash
Master
Sample
Difference

Edge

Add Show Mask

When viewing differences, click ‘Show Mask’ to select an option from the dropdown to change the way the differences are displayed.

Show Text Mask: When enabled, you can view the area on the master file that is considered ‘Text’ by GVD.
Mask: When enabled, a grey filter appears over the sample file creating a contrast between the differences and the rest of the file.
Numbers: When enabled, a number appears on each difference found and corresponds to the difference ID.
Boxes: When enabled, red boxes appear to display each difference found

Show Text Mask
Mask
MNumbers (ALT + H)

Boxes (ALT + H)

Overview Panel

The Overview panel displays the original Sample image. The difference that is selected is located at the intersection of the two red lines.

Ovennew



To zoom in or out of the Sample image in the Overview panel:

® Slide the button in the middle of the bar accordingly to navigate to the appropriate location.

Repeats Found Panel

The Repeats found panels list the number of repeats of the Master image that were found in the Sample image after the inspection has been
run. Repeats with differences display a red icon x to the left. Repeats without differences display a green checkmark /4] to the left instead.

Repeats found: 1 n
@ FRepeati

To navigate between repeats:

® Click the desired number on the list. The selected repeat appears in the Sample panel.

Master Panel
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GVD 5.10 Backup Color

Color Inspection Mode measures the color-space information of selected points on a master or sample or compares the color-space information
between corresponding points on the two files.

Points that fall outside of a configurable E (Delta-E 2000) tolerance level are detected as differences that need more attention, for the purposes of
improving or verifying color accuracy for printers and their clients.

The Color Inspection Mode icon is only accessible if it has been enabled as an add-on by an administrator.

GVD 5.10 Backup Color Inspection - Step-By-Step

GVD 5.10 Backup Color Inspection - Pre-Inspection Tools

GVD 5.10 Backup Color Inspection - Actions and Profiles

GVD 5.10 Backup Color Inspection - Post-Inspection Results Viewing
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GVD 5.10 Backup Color Inspection - Step-By-Step

Summary

This section describes the steps to follow when running a color inspection.
® Steps

Step 1: Load Electronic Files

Step 2: Load Scanned Files

Step 3: Select an Action

Step 4: Select Profile

Step 5: Select Colors to Measure

Step 6: Point to Point

Step 7: Create a Profile (Optional)

Step 8: Run the Inspection

Step 9: View the Results

Step 10: Go through differences to assign levels or comments

Step 11: Modifying/Resetting Inspection Results

Step 12: Generate the Report

Steps

Step 1: Load Electronic Files

) Note: Users can skip to Step 2 in case of Loading Scanned Files.

@ GlobalVision

D e B

|
Mew Job
Load Master (Ctrl + M)

Load Sample (Ctrl + 5)

® Click on the File Menu icon on the top panel then click Load Master or click in the Master panel to select the file to be loaded. The
Master image loads in the Master panel.

& Note: Only PDF and TIFF files with embedded ICC profiles are supported by Color Inspection.

® |f the file is a PDF:
®* The integrated PDF Options Panel displays.
® Prepare the Master image using the PDF Options tools, if required.

then,

® Click on the File Menu icon on the top panel then Load Sample or click in the Sample panel to start repeating the process to load
sample files.

Step 2: Load Scanned Files

) Note: Users can skip Step 2 if Electronic File is being loaded.

€3 Ensure Show Scanner Interface is checked on in the Preferences window.

Place the "ColorChecker Digital SG" chart in the Color Inspection-approved scanner in such a way that the output is in a landscape layout.



® Click on Load from Scanner then Select Source.

@ GlobalVision

=

A

Scan Master (Ctrl + Shift + M)

Select Source

® Select the applicable GlobalVision scanner (approved for Color Inspection) from the Scanner Selection window and click Select.

ﬁ Scanner Selection

® Click on Load from Scanner then Scan Master to scan the Master document. Once scanned the image loads in the Master panel.

then,

® Click Load from Scanner then Scan Sample to scan the Sample document. Once scanned the image loads in the Sample panel.

Step 3: Select an Action
Action

Single Page
Single Page
Point to Point

3

To compare points selected on a single master page to the same points on a single sample page or press sheet:

® SetAction Single Page.



To compare individual points selected on the Master with individual points selected on the Sample:

® Set Action Point to Point.

) Note: Multi-page files are not supported in Color Inspection Mode.

Step 4: Select Profile

® Click the Profile drop-down menu to access the list of available profiles.

£ Note: None is the default profile. Users of any type (standard users, managers, or administrators) can easily create profiles, which
consist of collections of points on a master (and sample, in the case of Point to Point inspections) to compare, just prior to running a
color inspection. For more information, see Step 8 Create a Profile (Optional).

Step 5: Select Colors to Measure
) Note: Users can skip to Step 6 to select Colors to Inspect.

® Click on the Color Inspector icon to launch the Color Inspector window.

if# Coler Inspector e

Color Book  PANTONE+ Solid | Color Point Details

Instructions for PDFs:

If Pantone color is spedified in separations, it will be
automatically detected with color picker. Otherwise,
search manually above.

Color Point Selection
Add points Sample size Tolerance AE

® Select the applicable Pantone color book from the drop-down list of the same name.

#) Note: To search the selected Pantone book for reference purposes, enter in a value in the Search for a Pantone prompt directly below
the Color Book drop-down list. The closest Pantone values display in the field directly below.

® Select the sample size (1x1 pixel, 2x2, 5x5) using the drop-down list of the same name.



B When moving the cursor over the Master, click on a color to display its LAB, CMYK, and RGB values (along with the closest Pantone
colors, which display directly underneath the Search for a Pantone prompt).

Alternatively,

® Click on the Add points icon and then on points on the Master, each of which gets listed under the Color Points heading, which
appears.

& Note: In the case of a PDF file, the Color Inspector automatically detects Pantone colors specified in the separations. Otherwise, the
closest Pantone matches display. In the event no Pantone match to a selected point is found, click on one of the closest matches (or
manually search for a Pantone and then click on it) to substitute it in under the Color Points heading.

To remove a Point:

® Toremove a specific point under the Color Points heading, click the "X" that appears to its far-right, beside the selected E level and
sample size.

To generate a Quick Report:

® Click on the Quick Report icon to launch the Report Options window and start the process of generating a report that includes all the L
AB, CMYK, RGB, and Pantone information, bypassing the inspection (comparison) process.

Step 6: Point to Point

® Click on the Add points icon and then on different points on the Master and Sample to compare to one another.

The points can be added in any sequence. The selected points get listed under the Color Points heading that appears, while the individual LAB,
CMYK, RGB, and Pantone values display above.



[ Colorin spector

Color Book  PANTONE+ Sali LT EE S

Warning! No Pantone found in PDF.
Select from the list below to update Color Point Detail.

PANTONE Black 6 C  AE 5.6
PANTONE 419 C
PAMTOM
PANTONE 7547 C
PAMTOMNE 426 C
PANTONE 433 C

PANTOME Bl:

Color Point Selection

Add points

Color Points

Master Sample

In the case of a PDF file, the Color Inspector automatically detects Pantone colors specified in the separations. Otherwise, the closest Pantone
matches display. In the event no Pantone match to a selected point is found, click on one of the closest matches (or manually search for a

Pantone and then click on it) to substitute it under the Color Points heading

To remove a Point:
® To remove a specific point from under the Color Points heading, click the "X" that appears to its far-right, beside the selected E level and

sample size.

Step 7: Create a Profile (Optional)



® Select Manage from the Profile drop-down list. Click Add and a prompt appear, requesting a name.
® Enter the name of the profile and click OK.

[ Color Profiles >

Import Export Copy

___*

® Select the newly created profile from the Profile drop-down list for the previously selected color points to take effect, prior to any
subsequent inspection (for repeat jobs with the same Master, for example).

£ Note: If a Point to Point profile is selected, the application automatically switches to the appropriate action if it had previously been set
to Single Page or One to One.

Step 8: Run the Inspection

® Click Inspect. The images are inspected and the differences display in the Inspection View Sample panel.

Step 9: View the Results

To view the inspected file:

® Use the trackwheel to zoom in or out.
® Hold the left mouse button and move it around to pan the image.

To view a repeat:

® Click on the desired repeat that appears in the Repeats found panel. It appears in the Inspection View Sample panel.

Step 10: Go through differences to assign levels or comments
Step 11: Modifying/Resetting Inspection Results

Step 12: Generate the Report

® Click the Report icon.
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Product ID

Product Mame

Inspected By Levels to indude

Indude:
Signature field Master

Only pages/frepeats with differences » Thumbnails

Report Path C:Wsers\smukherjee\Documents
Report File Mame Report.pdf

PDF Attachment

Comments




GVD 5.10 Backup Color Inspection - Pre-Inspection Tools

Summary

This section describes the Pre-inspection tools needed to inspect any file before running a Color inspection.
® Pre Inspection Tools
® Color Picker

Pre Inspection Tools

Color Picker

N

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master image:

® Click the Color Picker.
® Click an area in the image. The Color Picker window displays the LAB, CMYK, and RGB color-space values of the point selected.



GVD 5.10 Backup Color Inspection - Actions and Profiles

Summary

This section describes the default actions and profile associated with Color inspection.

Default Actions

Inspection

Color Inspection

Default Profiles

N/A

Custom Color Profiles

Single Page

Point to Point

Action

Description/ File Types
Compare a single master page to a single sample page or press sheet.

Master with individual points selected on the Sample.



GVD 5.10 Backup Color Inspection - Post-Inspection Results Viewing

Summary:

This section describes the post-inspection results viewing process and steps, needed after running a color inspection.
® Post Inspection Results
® Difference List
Overview Panel
Repeats Found Panel
Master Panel
Inspections Panel

Post Inspection Results

Difference List

To select a difference:
® Click on the difference in the Difference List. It gets highlighted in the Inspection View.
There are two primary ways to assign a level to a difference:

® Select the difference in the Difference List. Click in the Level column beside the difference in the same panel to load the Level drop-
down list and select the level. The color-coded level displays to the right of the difference.

Alternatively,

® Click the Level drop-down list in the Difference Details panel and select the level. The color-coded level displays to the right of the
difference in the Difference List.

) Note: Hotkeys (F1 — F5) may also be applied to assign levels. Select the difference and click the appropriate "F" key (see below):

1 Key Function

2 F1 Reporting level - Critical
3 F2 Reporting level - Major

4 F3 Reporting level - Minor

5 F4 Reporting level - Ignore
6 F5 Reporting level — None

To assign a level to multiple differences:

® Hold down the CTRL key while selecting the differences.
® Click the Level drop-down list, and select the level.

) Note: On a Mac operating system, to assign a level to multiple differences, hold down the COMMAND and SHIFT keys while selecting
the differences, click the Level drop-down box, and select the level.
To remove a level assignment:
® Click the Level drop-down list and select None. The level no longer displays in the Difference List.
To assign a comment to a difference:

® Select the difference in the Difference List. Click the Comments drop-down list and select one of the predefined comments that appear.
The selected comment displays whenever the difference is re-selected.

To assign a comment to multiple differences:

® Hold down the CTRL key while selecting the differences, click the Comments drop-down list, and select the comment.

) Note: On a Mac operating system, to assign a comment to multiple differences, hold down the COMMAND and SHIFT keys while
selecting the differences, click the Comments drop-down box, and select the comment.

To assign a customized comment to a difference:



® Select the difference in the Difference List, click in the Comments text box, and type in the comment.
To delete a comment from a difference:

® Click in the Comments drop-down box in the Difference List and select the blank entry.
To exclude a difference:

® Select the difference in the Difference List and click F12.

) Note: An administrator or user groups with Review settings access can configure the Application to force the inclusion of all differences,
in which case clicking F12 does not have an effect.

Overview Panel

The Overview panel displays the original Sample image. The color point that is selected is located at the intersection of the two red lines.

Chrenview

To zoom in or out of the Sample image in the Overview panel:

® Slide the button in the middle of the bar accordingly to navigate to the appropriate location.

Repeats Found Panel

The Repeats found panel lists the number of repeats of the Master image that were found in the Sample file after the inspection has been run.

& Note: This option is only applicable if the ‘Single Page’ action is selected.

To navigate between repeats:

® Click the desired number on the list. The selected repeat appears in the Sample panel.
Repeats found: 3 E
 RepeatiRowiColl

) Repeat 2 Row 2 Col
) Repeat 3 Row 3 Col 1

Master Panel

Inspections Panel


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Master-Panel
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GVD 5.10 Backup Barcode

This chapter describes the process for inspecting files containing barcodes. Barcode Inspection Mode detects and grades barcodes, displaying
details like decodability, magnification, quiet zones, etc.

Only administrators, managers, or user groups with ‘modify profile’ access, can create custom profiles that enable the feature or additional
parameters like grade output format (letters vs. numbers). For more information, see our Administration Guide.

) Please note, our Barcode Modules follow ISO standards:

® Linear ISO/IEC 15416:2000; ISO/IEC 15416:2016
¢ Data Matrix and QR ISO/IEC 15415:2011

. Overview Linear: Linear barcodes (1D barcodes) encode data by varying the widths and spacings of parallel lines to create specific

patterns. They contain a sequence of vertical black bars and white spaces that define a set of numbers or letters or characters. Because
of their limited storage space, these barcodes are used to retrieve information stored in a database.

. Overview Data Matrix: DataMatrix is a matrix (2D) barcode that may be printed as a square or rectangular symbol made up of individual

dots or squares. This representation is an ordered grid of dark and light dots bordered by a “finder pattern”. The data is encoded using a
series of dark or light dots based upon a pre-determined size. The square form is the most commonly used and enables the encoding of
the largest amount of data. The rectangular form with its limited height is better suited to some high-speed printing techniques and
unusual printing spaces.

. Overview QR: Quick Response (QR) Code is a type of matrix barcode (or two-dimensional barcode) used to store a variety of types of

data. It consists of black modules (square dots) arranged in a grid of white background. The required data is extracted from the patterns
present in both horizontal and vertical components of the symbol. QR codes are primarily used for marketing and advertising campaigns
and typically used a smartphone to read also enable the device to perform an action such as opening up a URL for a specific site.

GVD 5.10 Backup Barcode Inspection - Step-By-Step

GVD 5.10 Backup Barcode Inspection - Pre-Inspection Tools

GVD 5.10 Backup Barcode Inspection - Actions and Profiles

GVD 5.10 Backup Barcode Inspection - Post-Inspection Results Viewing
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GVD 5.10 Backup Barcode Inspection - Step-By-Step

Summary

This section describes the steps to follow when running a barcode inspection.
® Steps

Step 1: Load Electronic Files

Step 2: Load Scanned Files

Step 3: Select an Action

Step 4: Select Profile

Step 5: Run the Inspection

Step 6: View the Results

Step 7: Go through differences to assign levels and comments

Step 8: Modifying/Resetting Inspection Results

Step 9: Generate the Report

Steps

Step 1: Load Electronic Files

) Note: Users can skip to Step 2 in case of Loading Scanned Files.

[# GlobalVision

- 2 ¢4

F |

Mew Job
Load Master (Ctrl + M)

Load Sample (Ctrl + 5]

To inspect barcodes in a master file:

® Click on the File Menu icon on the top panel then click Load Master or click in the Master panel to launch the load-file window. The
Master image loads in the Master panel.

Or,
® You can also load a file by using "drag and drop."
® |f the file is a PDF:
®* The integrated PDF Options Panel displays.
® Prepare the Master image using the PDF Options Panel tools, if required.
then,

® Click on the File Menu icon on the top panel then Load Sample or click in the Sample panel to start repeating the process to load
sample files.

Step 2: Load Scanned Files

#) Note: Users can skip Step 2 if Electronic File is being loaded.



) Ensure Show Scanner Interface is checked on in the Preferences window.

® Click on Load from Scanner then Select Source.

® GlobalVision

=

F |

Scan Master (Ctrl + Shift + M)

Scan Sample (Ctrl + Shift + 5)

xelect Source

® Select the applicable scanner from the Scanner Selection window and click Select.

Hfi Scanner election

® Click on Load from Scanner then Scan Master to scan the Master document. Once scanned the image loads in the Master panel.
then,

® Click on Load from Scanner then Scan Sample to scan the Sample document. Once scanned the image loads in the Sample panel.

Step 3: Select an Action



Action

Inspect Master
Inspect Master

Inspect Sample

Inspect Master (All Pages)

Inspect Sample (All Pages)

To inspect a master file for barcodes:

® Click Action then Inspect Master (for masters placed in the Master panel).
To inspect a sample file for barcodes:

® Click Action then Inspect Sample (for samples placed in the Sample panel).
To inspect multi-page files or multiple files for barcodes:

® Click Action then Inspect Master (All Pages) (for masters placed in the Master panel).
® Click Action then Inspect Sample (All Pages) (for samples placed in the Sample panel).

Step 4: Select Profile

Before performing an inspection, the action and profile for the Barcode Inspection Mode must be set.

® Click the arrow on the Profile drop-down menu to access the different options, each of which has its parameters configured a certain
way to best accommodate specific scenarios.
® Click Profile. Then select the profile that best suits your inspection needs from the drop-down menu.

The following default profiles are installed with the system:
Profile

Default
Default
Rotated

Manage

1 Profile Description
2 Default Inspect master or sample files with barcodes in horizontal or vertical orientations
3 Rotated Inspect master or sample files with rotated barcodes; Detection speed is slightly slower

Users can also choose to have their own customized profiles. In order to customize your Barcode profile:

® Select on Profile then click on Manage.
® Click Add in Barcode Profiles and enter the custom parameters.

Note: For EAN-13, UPC-A, and UPC-E barcodes the height of the symbol at the nominal size is 22.85 millimeters (0.900 inches). The
nominal size is 100% magnification. Therefore, at 300 dpi, the height should be less than 300 pixels. If not, this can result in separate
magnification values for Default and Rotated profiles.

Step 5: Run the Inspection

® Click Inspect and the results display in the Inspection View.


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436287617/Barcode+Inspection+-+Actions+and+Profiles#Default-Actions

Barcodes found ; 1

| EAN 8

Barcode Details

A (L:100%

Quiet Zone

Data Structure

Marrow Bar A (0,35 mm)

BWR 0.00 mm

Wide To Marrow Ratio A

Wide Bar M/A

N/A

Decoded Value

51462444

Human Readable Value

51452944

Step 6: View the Results

To view the inspected file:

® To review the difference list navigate through them using either keyboard arrows or by clicking on each difference.
® Use the trackwheel to zoom in or out.



® Hold the left mouse button and move it around to pan the image.

Step 7: Go through differences to assign levels and comments
Step 8: Modifying/Resetting Inspection Results

Step 9: Generate the Report

® Click the Report icon.

# Note: If Digimarc support is enabled, all information regarding that aspect of the inspection is found appended to the PDF report. No
other action is required on the part of the user.

f# Report Options *

Product 1D

Product Mame

Inspected By Levels to indude

Indude:
Signature field Master
Only pages/repeats with differences » Thumbnails
Report Path ‘Ysers\moujaim\Documents
Report Fla Mame Report.pdf

PDF Attachment

Cormmenis

View Save Cancel
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GVD 5.10 Backup Barcode Inspection - Pre-Inspection Tools

Summary

This section describes the Pre-inspection tools needed to inspect any file before running a barcode inspection.
® Pre Inspection Tools
® Region Mode
® Crop to Contents
® Clear

Pre Inspection Tools

Region Mode

Region Mode lets you select an area in the image to be inspected.

) Note: The minimum cropping area is 100 x 100 pixels.

n order to select an area in the Master image to be used in the inspection:

® Click Region Mode and select one of the options:
® Crop: Left click and use the crosshairs to create the area to be inspected. A red box will appear surrounding the selected area.
® Trim: The largest bounding area of the image is selected. A red box will appear surrounding the selected area.
® Shape: Shape mode is used to detect a shape for repeat detection. Left-click on the shape to be used as the inspection area.
The selected shape displays in the Master panel.

) Note: You can also create a shape for repeat detection with the Crop tool, by creating the shape and clicking Crop to Contents
afterward.



WAR
Ea%c:h
Prod
Error

USU,
Reco

healt
Store

2444

5146

€3 If you right-click on a layer (e.g. dieline) and choose Set as shape region & hide or Use as shape region in the integrated PDF Viewer,
it automatically gets set as the Shape. Selecting the shape is key when inspecting repeats.

For crop and trim selections, additional options exist in the "Context" menu that appears by right-clicking:

® Choose between applying the selection to all, even, or odd pages in a multi-page file.
® Click Change to circle to replace the rectangular selection with a circular one.
® Click Clear all pages to remove the selection.

Crop to Contents




To tighten the crop selection so that it includes only the object:

® Click Region Mode and select Crop. Select an area using the crosshairs by click and drag. A red box will appear surrounding the
selected area.
® Click Crop to Contents.

) Note: The crop selection adjusts so that it contains only the revised selection.

Clear

Clear Master

Clear Sample

Click the Clear button

Select Clear All to remove markups on both Master and Sample files
Select Clear Master to remove markups on the Master file

Select Clear Sample to remove markups on the Sample files



GVD 5.10 Backup Barcode Inspection - Actions and Profiles

Summary

This section describes the default actions and profile associated with Barcode inspection.

Default Actions

Inspection Action
Barcode Inspection Inspect Master
Inspect Sample

Inspect Master (All Pages)

Inspect Sample (All Pages)

Default Profiles

Inspection Profile
Barcode Inspection Default
Rotated

Description/ File Types
Inspect a master file for barcodes.
Inspect a sample file for barcodes.

Inspect multi-page files or multiple files in the Master panel for
barcodes.

Inspect multi-page files or multiple files in the Sample panel for
barcodes.

Description/ File Types

Inspect master or sample files with barcodes in horizontal or vertical
orientations. Default will find and grade/decode barcodes at 0, 90, 180,
360 degrees (Multiples of 90 degrees)

Inspect master or sample files with rotated barcodes. Rotated will find
barcodes oriented outside of those 90 degrees multiples.

£ Note: At 300 dpi, the magnification tolerance is 1% and BWR tolerance is 0.01mm.

As a rule, increase the Resolution (Measurements) in Barcode Profile Settings for Default Barcode profile, to a higher dpi value, to get

more accurate results.



GVD 5.10 Backup Barcode Inspection - Post-Inspection Results Viewing

Summary

This section describes the post-inspection results viewing process and steps, needed after running a Barcode inspection.
® Post Inspection Results
® Review and Proof the Differences
Barcodes Found Panel
Barcode Details Panel
Overview Panel
Master Panel

Post Inspection Results

Review and Proof the Differences

® To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection View. The Barcode Details panel
displays its parameters and grades/values.

Barcodes found ; 1

1 EAN 8




arcode Details panel.

Barcode Details

Barcode 1

Grade

Diecodabil it:.l'

Magnification

Symbol Contrast

Min Edge Contrast

Modulation

Decode

Min Reflectance

Max Reflectance

Quiet Zone

Data Structure

Marrow Bar

BWE.

Wide To Marrow Ratio

Wide Bar

Gap

A(B1)
107.00 %
A (97.26)
A (97.29)

A (100)
A (D.00)
A (4.00)
A(2.79

100.00

A (L:100% R
100%G)

N/A

A (0.35 mm)

0.00 mm

N/A

N/A

N/A

® An overall (average) grade is determined for the barcode based on the values of the individual parameters. These grades appear in the B

® Consult the Barcode Scan Grid to find parameter grades for each of the selected barcode's scan lines (instead of the average).



Barcode Scan Grid

x>
x>
x>
x>
x>
x>
x>

ANSI/ISO Grade ﬂ

) Note: The Barcode Scan Grid appears only when 1D (linear) barcodes are inspected; The grades can be set to appear as numbers or
letters.

Letters are the default setting, while the Grade output format must be set to Numbers in the selected Barcode Inspection profile. Standard
users cannot create a new profile with the changed setting. Consult our Administration Guide for more information.



WARNINGS

Each Caplet Contail
Productivity boostel
Error eliminator

USUAL DOSAGE
Recommended by
heaith care practitio

Store between 20°-2

Barcodes Found Panel

To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection View.

The Barcode Details panel displays its parameters and the accompanying grades/values. The barcode itself gets highlighted in the Inspection
View.

Barcodes found : 1

1 EAN 8

Barcode Details Panel

When inspecting UPC or EAN barcodes, the Application determines whether a decoded value matches the Human Readable Value.

A match displays in green. A non-match displays in red. The panel's upper portion list each of the selected barcode's individual parameters. The
remainder of this section describes each of them in detail.



Barcode Details

Quiet Zone

Data Structure

Marrow Bar

EWER.

Decoded Value

51462444

Human Readable Value

51452944

2 Type
3 Grade
4 Decodability

5 Magnification

6 Symbol Contrast

8 Modulation

9 Defects

Min Edge Contrast

A (0,35 mm)

0,00 mm

1D/Composite Barcode Parameters

Barcode type detected

Overall grade for the barcode; See the table below for a list of barcode grades

Ease of barcode identification; The Application assigns a grade from A-F (100-0%)

Percentage (+/- 10%) that a barcode has been magnified based on a starting point of 100%; Based on width
to accommodate truncated barcodes and can vary from 80% to 200% except for Interleaved 2 to 5-type

codes

Difference in the contrast between the darkest and the lightest parts of a barcode; The system assigns a
grade from A-F (100-0%)

Minimum contrast between a space and its adjacent bars; The Application assigns a pass-or-fail grade (A or
F) (100-0%)

The ratio between symbol contrast and minimum edge contrast; The Application assigns a grade from A-F
(100-0%)

Amount of discrepancies in the reflectance of a barcode; The Application assigns a grade from A to F (100-
0%)



10

11

12

13

14

15

16

17

18

19

20

10

11

12

13

14

15

16

Decode

Min Reflectance

Max Reflectance

BWR

Decoded Value
Quiet Zone

Data Structure

Narrow Bar

Wide Bar

Wide to Narrow Ratio

Gap

Determination of whether the barcode was generated correctly, with sufficient spacing between bars; The
system assigns a pass-or-fail grade (A or F; 4 or 0)

Minimum reflectance value (darkest part of the barcode); The Application assigns a pass-or-fail grade (A or
F)

Maximum reflectance value (the lightest part of the barcode); The Application assigns a rating from 100-0

A measure of the decrease in bar width needed to compensate for print gain; The Application assigns a
measurement in mm

The decoded value of the selected barcode
Blank margins bordering a barcode; The Application assigns a pass-or-fail grade (A or F; Left% and Right %)

Type of information that is embedded in the barcode; The Application analyzes applicable barcodes as
either having valid (A) or invalid (F) data structures (GS1 data matrix and QR codes only)

Width of the narrow bars comprising the barcode in mm; Higher DPI values yield more precise results; The
Application assigns a pass-or-fail grade (A or F)

Width of the wide bars comprising the barcode in mm; Higher DPI values yield more precise results; The
Application assigns a pass-or-fail grade (A or F)

The ratio that determines narrow and wide bar widths (NB: WB); The Application assigns a pass-or-fail
grade (A or F)

Amount of space between the last black bar of one character and the first of another in mm; The Application
assigns a pass-or-fail grade (A or F)

2D Barcode Parameters

Type
Grade

Symbol Contrast

Modulation
Decode

Axial Non-
Uniformity

Grid Non-
Uniformity

Fixed Pattern
Damage

Unused Error
Correction

Decoded Value

BWR Horizontal

BWR Vertical

Data Structure

Cell Size

Quiet Zone

Barcode type detected
Overall grade for the barcode; See the table below for descriptions

Difference in the contrast between the darkest and the lightest parts of a barcode; The Application assigns a grade
from A-F (100-0%)

The ratio between symbol contrast and minimum edge contrast; The Application assigns a grade from A-F

Determination of whether the barcode was generated correctly, with sufficient spacing between bars; The Application
assigns a pass-or-fail grade (A or F; 4 or 0)

Difference in length of the two axes of the barcode; The Application assigns a grade from A-F (0-100%)

Vector deviation of the barcode from an ideal position; The Application assigns a grade from A-F (0-100%)

Damage done to the pattern; The Application assigns a grade from A-F

Amount of unused error correction embedded in the barcode; The Application assigns a grade from A-F

The decoded value of the selected barcode

A measure of the decrease in horizontal bar width needed to compensate for print gain; The Application assigns a
measurement in mm

A measure of the decrease in vertical bar width needed to compensate for print gain; The Application assigns a
measurement in mm

Type of information that is embedded in the barcode; The Application analyzes applicable barcodes as either having
valid ("A") or invalid ("F") data structures (GS1 data matrix and QR codes only)

Height and width of a cell comprising the data matrix (QR code); The Application assigns a measurement in mm

Blank margins bordering a barcode; The Application assigns a pass-or-fail grade (A or F; Left% and Right %)



Barcode Grades

Grade Color Color Code
A #8BC5H3F

B #08C8F4

C #FFFBOO

D #FFC920

F #FFAC3F
N/A N/A

Overview Panel

Description

Overall grade of 3.5 or higher; The barcode should scan easily the first time with most barcode
scanning equipment

Overall grade of 2.5 - 3.5; The barcode may scan easily the first time and there is a high
probability of success if a second scan is performed

Overall grade of 1.5 - 2.5; The minimum most barcodes should achieve
Acceptable only if the barcode is printed on fiberboard
Failing grade

The verification grade of the barcode symbol is not supported

The Overview panel displays the image or inspection currently being viewed in the Inspection View. The selected barcode is located at the

intersection of two red lines.

Crverview

P L] o

L S

e 0} |

To zoom in or out of the Sample image in the Overview panel:

¢ Slide the button in the middle of the bar accordingly to navigate to the appropriate location.

Master Panel

Inspections Panel


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Master-Panel
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Inspections-Panel

GVD 5.10 Backup Braille

Braille Inspection Mode lets you inspect and translate Braile regions on separate master or sample files. The Application supports digital
documents and scanned copies of files containing Braille of either plateau, dome, or bell dot types.

We follow Marburg Medium Braille Specification, with Dimensions:

2.5mm horizontal dot to dot

2.5mm vertical dot to dot

6.0mm from cell to cell

12.0mm from cell to cell with a single space in between
10.0mm line spacing

Tolerances: + 0.1mm; Dot diameter: 1.3-1.6mm

Both frontside and backside scans are in turn supported, with Braille height information displayed following inspections of the former.

) Note: High-gloss samples may require an additional finish for the Application to properly support scanning them.

There are four default actions (inspection types) available:
Translate Master inspects a loaded master file, providing a translation of its Braille and a list of measured parameters.

Inspect Braille Sample inspects a scanned sample file (frontside), providing a translation of its Braille and a list of measured parameters. Braille
height information does display when a scanned sample is inspected.

Compare PDF to Scan (Backside) compares Braille regions detected on the scanned Sample (backside) against detected Braille regions on
the loaded Master.

Compare PDF to Scan (Frontside) compares Braille regions detected on the scanned Sample (frontside) against detected Braille regions on
the loaded Master. Braille height information does display in this scenario.

The system marks individual Braille dots as missing or extra (Compare) while letting the user modify the translation by adding/ removing
dots (Translate/ Inspect).

Braille Standard and Guidelines

Master file must be original artwork in PDF, BMP, or TIFF format
Braille dots must be on top-most layer

Braille dots must be solid-filled

Braille dots must be a unique color

Braille dot spacing should follow Marburg Medium Standard

GVD 5.10 Backup Braille Inspection - Step-By-Step

GVD 5.10 Backup Braille Inspection - Pre-Inspection Tools

GVD 5.10 Backup Braille Inspection - Actions and Profiles

GVD 5.10 Backup Braille Inspection - Post-Inspection results Viewing
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GVD 5.10 Backup Braille Inspection - Step-By-Step

Summary

This section describes the steps to follow when running a Braille inspection.

® Steps

® Step 1: Load Master Files for Braille Translation
® Step 2: Scan Sample Files for Braille Inspection
® Step 3: Load/Scan Files for Braille Compare
® Step 4: Select an Action
® Step 5: Select Language
® Step 6: Run the Inspection
® Step 7: View the Results
® Step 8: Review and Proof Differences
® Step 9: Modifying/Resetting Inspection Results
® Step 10: Generate the Report

Steps

Step 1: Load Master Files for Braille Translation

) Note: Users can skip to Step 2 for Sample Inspection.

@ GlobalVision

|
Mew Job

Load Master (Ctrl + M)

Load Sample (Ctrl + 5]

To inspect afile in the Master panel:

® Click on the File Menu icon on the top panel then click Load Master or click in the Master panel to select the file to load. The Master
image loads in the Master panel.

Or,
® You can also load a file by using "drag and drop."

® |[f the file is a PDF:
®* The integrated PDF Options Panel displays.
® Prepare the Master image using the PDF Options Panel tools, if required.
® |f afile has multiple pages, ensure the one with the Braille regions displays prior to the inspection.

Step 2: Scan Sample Files for Braille Inspection
) Note: Users can skip Step 3 for comparison.

To inspect afile in the Sample panel:



) Ensure Show Scanner Interface is checked on in the Preferences window.

® Click on Load from Scanner then click Select Source.

® GlobalVision

5 e @

F |

Scan Master (Ctrl + Shift + M)

»can Sample (Ctrl + Shift + 5)

Select Source

® Select the applicable scanner from the Scanner Selection window and click Select.

[ﬁi Scanner election

) Note: Itis recommended to select Calibrate Scanner before making your first scan and whenever the device has been calibrated
independently of the system. Restart the Application for the Calibrate Scanner (Braille) option to appear at the bottom of the same
menu.

then,

® Place the front side of the sample on the scanner. Click on Load from Scanner then click Scan Sample. The Sample image loads in
the Sample panel.

Step 3: Load/Scan Files for Braille Compare
) Note: Users can skip to Step 4 if Files are already loaded/scanned.

To Load file for comparison:



® Click on the File Menu icon on the top panel then click Load Master or click in the Master panel to select the file to be loaded. The
Master image loads in the Master panel.

If the file is a PDF:
®* The integrated PDF Options Panel displays.
® Prepare the Master image using the PDF Options Panel tools, if required.
If the file has multiple pages, right-click on the Master page featuring the Braille regions in the

then,
Again click the File Menu icon on the top panel then click Load Sample or click in the Sample panel to start repeating the process to
load the Sample file.

Step 4: Select an Action

Action
Translate Master
Translate Master

Inspect Braille Sample

Compare PDF to Scan (Backside)

Compare PDF to Scan (Frontside)

To translate a master file:
® Click on Action then select Translate Master.

To inspect a Braille sample file:
® Click on Action then select Inspect Braille Sample.

To compare Braille regions on a digital master to their counterparts on the backside of a Braille scan:
® Click on Action then select Compare PDF to Scan (Backside).

To compare Braille regions on a digital master to their counterparts on the frontside of a Braille scan:

® Click on Action then select Compare PDF to Scan (Frontside).

B The settings for each action can be browsed by clicking Action Settings.

Individual settings may be modified by users with administrative privileges, while additional actions can also be created. For more
information see our Administration Guide.

Step 5: Select Language



Profile

English

ALED R
Basgue (Spain)
Belarusian
Bulgarian
Catalan (Spain)
Croatian

Czech

Danish

T

EBU

English

English (UK)
Estonian
Faroese (Denmark)

Finnish

French {Antoine)

French (Traditional)

® Click the Profile drop-down menu to access the Application’s library of available languages. Select the language that best suits your
inspection needs from the drop-down menu.

Step 6: Run the Inspection

® Click for the results to display in the Inspection View.

OLA_GVVT_Master. pdl

SECURE 7% SECURE
YOLIR BRAMD SESI

- > EBRAMND
PACKAGIMNG ' - PACKAGING

Hasic Brdcrmmacion

Step 7: View the Results

To view the inspected file:



® To review the difference list navigate through them using either keyboard arrows or by clicking on each difference.
® Use the trackwheel to zoom in or out.
® Hold the left mouse button and move it around to pan the image.

Step 8: Review and Proof Differences
Step 9: Modifying/Resetting Inspection Results

Step 10: Generate the Report

® Click the Report icon.
f# Report Options *

Product 1D

Product Mame

Inspected By e to indude

Indude:
Signature field Master
Only pages/repeats with differences » Thumbnails
Report Path ‘Ysers\moujaim\Documents
Report Fla Mame

PDF Attachment

Cormmenis

View Save Cancel
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GVD 5.10 Backup Braille Inspection - Pre-Inspection Tools

Summary

This section describes the Pre-inspection tools needed to inspect any file before running a Braille inspection.
® Pre Inspection Tools
® Region Mode
® Crop to Contents
® Clear

Pre Inspection Tools

Region Mode

Region Mode lets you select an area in the image to be inspected.

) Note: The minimum cropping area is 100 x 100 pixels.

n order to select an area in the Master image to be used in the inspection:

® Click Region Mode and select one of the options:
® Crop: Left click and use the crosshairs to create the area to be inspected. A red box will appear surrounding the selected area.
® Trim: The largest bounding area of the image is selected. A red box will appear surrounding the selected area.
® Shape: Shape mode is used to detect a shape for repeat detection. Left-click on the shape to be used as the inspection area.
The selected shape displays in the Master panel.

) Note: You can also create a shape for repeat detection with the Crop tool, by creating the shape and clicking Crop to Contents
afterward.
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&3 If you right-click on a layer (e.g. dieline) and choose Set as shape region & hide or Use as shape region in the integrated PDF Viewer,
it automatically gets set as the Shape. Selecting the shape is key when inspecting repeats.
For Crop and trim selections, additional options exist in the "Context" menu that appears by right-clicking:

® Choose between applying the selection to all, even, or odd pages in a multi-page file.
® Click Change to circle to replace the rectangular selection with a circular one.
® Click Clear all pages to remove the selection.

Crop to Contents

To tighten the crop selection so that it includes only the object:

® Click Region Mode and select Crop. Select an area using the crosshairs by click and drag. A red box will appear surrounding the
selected area.
® Click Crop to Contents.

) Note: The crop selection adjusts so that it contains only the revised selection.


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1439203447/Barcode+Inspection+-+Pre-Inspection+Tools#Region-Mode

Clear

Clear All

Clear Master

Clear Sample

Click the Clear button

Select Clear All to remove markups on both Master and Sample files
Select Clear Master to remove markups on the Master file

Select Clear Sample to remove markups on the Sample files



GVD 5.10 Backup Braille Inspection - Actions and Profiles

Summary

This section describes the default actions and profile associated with Braille inspection.

Default Actions

Inspection Action Description/ File Types
Braille Inspection Translate Master Translate the Braille in a digital master file.
Inspect Braille Sample Inspect the frontside Braille in a(scanned) sample file.

Compare PDF to Scan (Backside) Compare Braille regions on a digital master to their counterparts on the
backside of a Braille scan.

Compare PDF to Scan (Frontside) = Compare Braille regions on a digital master to their counterparts on the
frontside of a Braille scan.

) Note: Only Braille Inspection actions can be added to the mode’s drop-down list.

Users with administrative privileges possess the unique ability to add, rename, and delete Braille actions as well as modify their
respective individual parameter values.

Default Profiles

Inspection Profile Description/File Types

Language Braille languages to choose from when
inspecting master or sample files or
comparing the two. Custom Braille
Language is also supported.

Braille Inspection



GVD 5.10 Backup Braille Inspection - Post-Inspection results Viewing

Summary

This section describes the post-inspection results viewing process and steps, needed after running a Braille inspection.
® Post Inspection Results
® Review the Differences
Modify the Dots (if Necessary)
Braille Regions Found Panel
Braille Details Panel
Master Panel
Overview Panel

Post Inspection Results

Review the Differences

® Click on the Braille region to be inspected in the Braille Regions found panel. It gets highlighted and displayed in the Inspection View.

When running Braille comparison, missing (highlighted with a “minus” sign”) and extra dots (highlighted with a “plus” sign) get
identified accordingly.

Modify the Dots (if Necessary)



To add a Braille dot:

® Select the Braille region in the Braille panel. CTRL-left-click on the dot that is missing. A black “+” displays in the dot and the translation
gets modified in the Braille Details panel, highlighted in red.

To remove a Braille dot:

® CTRL-left-click on the extra dot in the Inspection View. A black "-" displays in the dot and the translation gets changed accordingly in the
Braille Details panel, highlighted in red.

To cancel the Braille dot modification:

® CTRL-left-click on the dot. The added "+" or "-" is removed from the dot and the translation gets changed accordingly in the Braille
Details panel with the highlight removed.
Braille Regions Found Panel

To navigate to a Braille region, click on it in the Braille panel. The Braille Details panel displays its translation and different parameters. The
region itself gets highlighted in the Inspection View.



Eraille Regions found : 1

Region 1

Braille Details Panel

The selected region's details display in the Braille Details panel for further review, with any differences between the Master and Sample files
(during Braille Compare PDF to Scan inspections) highlighted.

If one of the Braille Parameters appears in red, it has failed the ISO Standard 17351:2013 for dot diameter and spacing.



Braille Details
Braille Region 1
Language: English
Action: Translate Master

Translation

Basic Information
Dots
Characters

Lines

Braille Parameters
DotH Spacing 2.4mm

24mm

® Braille Detection Options

If the braille dots have not been de within the braille region, try
CTRL +Click on & cell to add/remaovw

If the braille region has not been correctly identified, go back and use the
marquee tool, Alternatively, a backside scan and inspection can be performed.

The following table describes the individual parameters found in the Braille Details panel:

1 Braille Details

2 Braille Region Region selected

3 Language Language of translation

4  Action Selected action of inspection

5 Translation Translation of Braille in the selected language; When the Master and Sample files are being compared,

separate Master/ Sample Translation fields display
Note: Unrecognized Braille characters are represented by an underscore.



6 Dots Number of dots
7 Characters Number of characters
8 Lines Number of lines detected

9 Height Information (inspections w/ frontside scans only)

10 Dot Type Type of dots detected (dome, bell, plateau)

11 % Acceptable Percentage of detected dots above the set threshold (%)

12 Mean Height The average height of detected dots (mm)

13 Min/Max Height The Minimum and the maximum height of detected dots (mm)
14 Standard Deviation Standard deviation in height of detected dots (mm)

15 Braille Parameters

16 Dot H Spacing Average horizontal spacing between dots (mm)
17 Dot V Spacing Average vertical spacing between dots (mm)
18 Character Spacing Average spacing between characters (mm)

19 Word Spacing Average spacing between words (mm)

20 Line Spacing Average spacing between lines (mm)

Master Panel

Inspections Panel

Overview Panel

The Overview panel displays the image or inspection currently being viewed in the Inspection View. The Braille region currently selected is
indicated by the intersection of the two red lines.

Ohverview

To zoom in or out of the image in the Overview panel:

® Slide the button in the middle of the bar accordingly to navigate to the appropriate location.


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Master-Panel
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GVD 5.10 Backup Spelling

Spelling Inspection Mode checks the spelling of a loaded file or scanned document. The Application verifies the text against any one of 37
different featured languages to help ensure the quality of the copy on both packaging components and collateral.

Custom, company-specific terms can be added to any dictionary by administrators, while all loaded files are automatically run against an
English medical dictionary for increased inspection accuracy.

GVD 5.10 Backup Spelling Inspection - Step-By-Step

GVD 5.10 Backup Spelling Inspection - Pre-Inspection Tools

GVD 5.10 Backup Spelling Inspection - Actions and Profiles

GVD 5.10 Backup Spelling Inspection - Post-Inspection Results Viewing
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GVD 5.10 Backup Spelling Inspection - Step-By-Step

Summary

This section describes the steps to follow when running a spelling inspection.
® Steps
Step 1: Load Files for Spelling Inspection
Step 2: Load Scanned Files
Step 3: Select an Action
Step 4: Select a Language
Step 5: Ensure proper Inspection Area is selected using the Pre-Inspection Tools
Step 6: Run the Inspection
Step 7: View the Results
Step 8: Go through differences to assign levels and comments
Step 9: Modifying/Resetting Inspection Results
Step 10: Generate the Report

Steps

Step 1: Load Files for Spelling Inspection

# GlobalVision

o 2

A

Mew Job
Load Master (Ctrl + M)

Load Sample (Ctrl + 5)

To inspect spelling:

® Click on the File Menu icon on the top panel then Load Master or click in the Master panel to launch the load-file window. The Master

image loads in the Master panel.

Or,
® You can also load a file by using drag and drop.
¢ |f the file is a PDF:
®* The integrated PDF Viewer displays.
® Prepare the Master image using the PDF Viewer tools, if required. Click Inspect for the results to display in the Inspection View.
then,

® Click on File Menu then Load Sample or double-click in the Sample panel and follow the same steps as above.

£ Note: You can upload a file as a Master or a Sample. It is not necessary to upload both.

Step 2: Load Scanned Files

) Note: Users can skip Step 2 if Electronic File is being loaded.



[ GlobalVision

o 2 ¢

F |

Scan Master (Ctrl + Shift + M)

xcan Sample (Ctrl + Shift + 5)

lect Source

® Click on Load from Scanner then Select Source.

ffi Scanner Selection

Select Cancel

® Select the applicable GlobalVision scanner from the Scanner Selection window and click Select.

® Click on Load from Scanner then Scan Master to scan the Master document. Once scanned the image loads in the Master panel.
then,

® Click on Load from Scanner then Scan Sample to scan the Sample document. Once scanned the image loads in the Sample panel.

Step 3: Select an Action
Action

Inspect Sample (All Pai_hrs}

Inspect Master (All Pages)
Inspect Sample (All Pages)

To inspect the file in the Master panel for spelling:

® Click Action Inspect Master (All Pages).



To inspect the file in the Sample panel for spelling:

® Click Action Inspect Sample (All Pages).

Step 4: Select a Language

Profile

English

Albanian

Basque (Spain)

Belarusian
Bulgarian
Catalan (Spain)
Croatian

Czech

Danish

Dutch

EBU

English

English (UK)
Estonian
Faroese (Denmark)
Finnish

French (Antoine)

French (Traditional)

® Click the Profile drop-down menu to access the Application's library of available languages. Select the language that best suits your
inspection needs from the drop-down menu.

Step 5: Ensure proper Inspection Area is selected using the Pre-Inspection Tools

Step 6: Run the Inspection

® Click Inspect. The files are inspected and the differences display in the Inspection View.
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Step 7: View the Results

To view the inspected file:

® To review the difference list navigate through them using either keyboard arrows or by clicking on each difference.
® Use the trackwheel to zoom in or out.
® Hold the left mouse button and move it around to pan the image.

Step 8: Go through differences to assign levels and comments

Step 9: Modifying/Resetting Inspection Results

Step 10: Generate the Report

® Click the Report icon.
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# Report Options

Product ID
Product Mame
Inspected By IR

Incude:

Signature field

Only pages/repeats with differences » Thumbnails

Report Path C:\Wsers\fmoujaimDoouments
Report File Mame Report.pdf

PDF Attachment

Comments

Vil Save Cancel




GVD 5.10 Backup Spelling Inspection - Pre-Inspection Tools

Summary

This section describes the Pre-inspection tools needed to inspect any file before running a Spelling inspection.
® Pre-Inspection Tools
® OCR
Show Inspectable/Live Text Tool
Cross-Out Text Tool
Underline Text Tool
Clear All
Show/Hide

Pre-Inspection Tools

OCR

lock
-

-

OCR stands for Optical Character Recognition. Assuming that you have an internet connection, the tool can transform non-live text, like one
would find on a scanned document for example, to inspectable text for the purposes of inspecting text or spelling.

) Note: A live-text file is ideal for accurate quality control. In the absence of a live-text file, OCR can be useful, but is unsupported by
GlobalVision; False positives and/ or missed differences may result.

To use OCR when running a text or spelling inspection on files featuring non-live text:

® Click the Region Mode icon and select Marquee.

® Left-click and use the crosshairs that appear to select the desired non-live text. A red box surrounds the selected area. Resize/ move it
as necessary by clicking and dragging its borders.

® Click OCR to process the text. If applicable, crop the corresponding text in the Sample panel (for Text Inspection).

) Note: To marquee additional regions, repeat the steps above, avoiding overlap.
Click Inspect to run the inspection. The differences display as they normally would following an inspection.

) Note: If there was live text on the file, it is detected pre-inspection as well, regardless of whether it had been cropped. However, during
text inspections, only the marqueed text gets checked. In contrast, during a spelling inspection, all live text gets verified.

Show Inspectable/Live Text Tool

The ‘live text’ tool shows all live text (in Text or Spelling Inspection modules) in the Master or Sample panel:
To show live text:

® Click on the corresponding Live Text icon.
To remove live text:

® Click the icon again.



) Note: Text that is not live can still be inspected as part of a pixel-to-pixel comparison between two similarly laid-out files in Graphics
Inspection.

Cross-Out Text Tool

The Cross-out tool can be found at the top of the Master and Sample panel. Cross-out allows you to cross out a text to be excluded in the
inspection. The text is crossed out in red.

To cross-out Text:

® Click the Cross-out Text icon in either the Master or Sample panel.
® Click and drag the crosshairs icon that appears as the cursor, over the text, to be excluded in either the Master or Sample panel. Multiple
selections can be made.

To apply a cross-out to different portions of a multi-page file:

® Right-click on the crossed-out text.
® |n the “Context” menu that appears, select to apply the cross-out to all pages, odd pages, even pages, or identical text elsewhere in the
file.

Apply to this page

Apply to all pages
Apply to odd pages

telieves Sinus & ST
Cross-out identical text

48 Capaules Clear

Clear All

® Clear removes cross-outs that are selected, Clear All removes all cross-outs.
To cancel out underlined text using Cross-out Text:

® Click on Underline Text.
® Click and drag the crosshairs icon that appears as the cursor over the crossed-out text.
® The cross-outs are removed.

) Note: Cross-out Text and Underline Text cannot otherwise be applied together in the same file unless it is to cancel the other one out

Underline Text Tool

Underline Text lets you select text to be included in the inspection.

To underline a Text:



® Click Underline Text on the selection toolbar and then click and drag the cursor to select the desired text. The text is underlined in green.

) Note: Clear removes the currently selected underlined text. Clear All removes all underlines.

To clear all underlines, cross-outs, or zones in a master or sample file:

® Clear removes underlined text that is selected, Clear All removes all underlined text.

Clear All

To clear all underlines, cross-outs, or zones in a master or sample file:

® Click the Clear All icon. A message appears, asking if you want to continue.
® Click Yes.

Show/Hide

To toggle the appearance of all underlines, cross-outs, or zones on or off in a master or sample file, either before an inspection or after:

® Click the Show/Hide icon.



GVD 5.10 Backup Spelling Inspection - Actions and Profiles

Summary
This section describes the default actions and profile associated with Spelling inspection.

Default Actions

Inspect the file in the Master panel for spelling.

Spelling Inspection Inspect Master (All Pages)

Inspect Sample (All Pages) Inspect the file in the Sample panel for spelling.

Default Profiles

Languages to choose from when inspecting master or sample files for
spelling. Custom wordlist is also supported.

Spelling Inspection Language




GVD 5.10 Backup Spelling Inspection - Post-Inspection Results Viewing

Summary

This section describes the post-inspection results viewing process and steps, needed after running a Spelling inspection.
® Post-Inspection Results
® Difference List
® Master Panel
® Inspections Panel

Post-Inspection Results

Difference List

The Difference List displays the differences between the Master and Sample files for easy reviewing and proofing. The column headings include
ID, Page, Type, Sample (the difference as it appears in the Sample), Comment, and Level.

To select a difference:

® Click on the difference in the Difference List. It gets highlighted in the Inspection View.
Differences found: 32

Sample Comment
DocuProof

DocuProof

Spelling Comparater

Spelling documants
documants
documants

To assign a level to a difference:

® Select the difference in the Difference List. Click the Level column and select the level in the drop-down list that appears. The color-
coded level displays in the Difference List to the right of the difference.

) Note: Hotkeys (F1 — F5) may be applied to assign levels. Select the difference and click the appropriate "F" key (see below):

1 Key Function

2 F1 Reporting level - Critical
3 F2 Reporting level - Major

4 F3 Reporting level - Minor

5 F4 Reporting level - Ignore
6 F5 Reporting level — None

To assign a level to multiple differences:

® Hold down the CTRL key while selecting the differences, click the Level column, and select the level.

) Note: On a Mac operating system, to assign a level to multiple differences, hold down the COMMAND and SHIFT keys while selecting
the differences, click the Level column, and select the level.

To remove a level assignment:
® Click the Level column and select None. The level no longer displays in the Difference List.

To assign a comment to a difference:



® Select the difference in the Difference List. Click the Comment column and select one of the predefined comments that appear. The
selected comment displays.

To assign a comment to multiple differences:

® Hold down the CTRL key while selecting the differences, click the Comment column, and select the comment.

) Note: On a Mac operating system, to assign a comment to multiple differences, hold down the COMMAND and SHIFT keys while
selecting the differences, click the Comment column, and select the comment.
To assign a customized comment to a difference:

¢ Select the difference in the Difference List, click the Comment column, select Freeform, and type in the Comments text box in the Diff
erence window that appears. Click OK for it to take effect.

To delete a comment from a difference:
® Click in the Comment column in the Difference List and select None. Click elsewhere for it to take effect.
To assign a suggested replacement for a difference from the selected dictionary:

® Right-click on a difference and select the desired word that displays in the menu that pops up. It appears under the Comment field in
that row.

To add a detected spelling mistake to the selected dictionary (administrators, managers, or user groups with ‘modify profile’ access
only):

® Right-click on a difference and select Add to current dictionary. Click OK to the confirmation message that appears.

) Note: Allinstances of that same spelling mistake no longer appear as differences once it has been added and the inspection is re-run.

To exclude a difference:

® Select the difference in the Difference List and click F12. The difference gets crossed out.

) Note: An administrator or user groups with Review settings access can configure the Application to force the inclusion of all differences,
in which case clicking F12 does not have an effect.

Master Panel

Inspections Panel


https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Master-Panel
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1436352603/Layout#Inspections-Panel

GVD 5.10 Backup Modifying/Resetting Inspection Results

Retain Inspection Results and Run a New Inspection

I

® Click Back. The Main View displays with the Master and Sample images loaded. To load new files, follow the steps described under the
Step-by-Step section.

® Click Inspect. The files are inspected, and the differences display in the Inspection View. Each subsequent retained inspection gets
listed in the Inspections panel.

Clear Inspection Results and Run a New Inspection

<

® Click Reset. A message displays, asking if you want to continue.

[ Reset >

Inspections and Documents will be cleared. Click Yes to continue.

Yes Mo

® Click Yes to clear inspection results and documents. The Main View displays.



GVD 5.10 Backup Report Generation

Summary

The following section describes the steps involved with generating a report, which is the culmination of the inspection process. The Report button
only appears after an inspection has been completed.

) Note: Multiple inspections can be combined into one report. Whatever inspections have been run and have not been specifically
excluded appear in the generated PDF.

® Report Generation

® Generate a report
® Include Inspections in Report

Report Generation

Generate a report

® Click Report. The Report Options window displays. Fill in the Report Options window where applicable.

) Note: The Inspected By field is pre-populated with the user name and no modifications are allowed. All other fields, except Status,
which must be modified from the Select Status default, are optional.

Report Options
Product ID
Product Name
Inspected By
Status
Product Lot
Levels to Include
Only Pages/Repeats
with differences
Master

Signature field

Thumbnails
Report Path
Report File Name
PDF Attachment

Comments

Action
Enter the Product ID; The Report File Name below automatically reflects the entered value
Enter the Product Name
No action required; The field is automatically populated with the name of the user who performed the inspection
Select Pass/Fail (required)
Enter the Lot Number; The Report File Name below automatically reflects the entered value

Only differences with levels matching selection(s) are included in report; Does not appear if "Force inclusion of all
differences” has been selected by an administrator

Check to include only the pages or the repeats that have at least one difference

Check to include the Master image (where applicable)

Check to include the signature field (Performed By, Reviewed By fields) in the report; Automatically included when
the licensed option to Enable Electronic Signatures in the Settings window has been selected by an administrator

Check to include thumbnails of each difference (Graphics, Text, and Spelling Inspection only)
Select where the report gets saved

Set the name of the report to be saved

Browse for and attach a PDF to the report

Enter general comments to be included in the report

® Click Save & View or Save.



® Click on either Pass or Fail to set the inspection status.

® Click Cancel to return to the Report Options window.

) i the licensed option to Enable Electronic Signatures has been checked by the administrator in the Settings window (via the Menu),
the Electronic Signature window displays.
® |n case Save had been selected in the Report Options window, the report is saved in the selected (or default) report path.
® In case Save & View had been selected, the report saves in the selected (or default) report path and displays in the default PDF reader

All inspections are included in the report (if applicable).
® Fill in the User Name and Password fields (as you would log in) and click Sign. Or, click Cancel to return to the Report Options

window.

Include Inspections in Report

The Application lets you rename inspections and/or exclude them from the report. This option is available under the Inspections panel.

Rename the inspection:

® Right-click on the inspection name in the Inspections panel. Click Rename.
® Enter the desired name and click OK. The new name displays in the Inspections panel.

Exclude the inspection from the report:

® Right-click on the inspection name in the Inspections panel. Click Exclude from the report.
® The inspection name gets crossed out in the Inspection Panel. The inspection is not included in the next generated report.



GVD 5.10 Backup Tools and Profile Settings

This section includes toolbars, tools, profile settings, and any other associated settings applicable to each inspection type.
® GVD 5.10 Backup Main Toolbar
® GVD 5.10 Backup Tools (Master & Sample)

GVD 5.10 Backup Page Selection Toolbar

GVD 5.10 Backup Document Viewer

GVD 5.10 Backup Profile Settings


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931493559/GVD+5.10+Backup+Main+Toolbar
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931493647
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931493920/GVD+5.10+Backup+Page+Selection+Toolbar
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931494103/GVD+5.10+Backup+Document+Viewer
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931494196/GVD+5.10+Backup+Profile+Settings

GVD 5.10 Backup Main Toolbar

Summary

The Main toolbar is the first element visible on top of the application interface once the user logs into the system and prepares for any Inspection.
o X

& Gicheivision

It is comprised of several significant tools required to successfully load a file either as a PDF or from a scanner directly into the system.

It also shows details on each type of Inspection module available to the user, Report options, Help, and Menu options. Each of these modules is
explained with their available options below and covered in more detail over different upcoming sections.

v

Load from Reset Interface Inspection View

Scanner

Available Options under each Menu

® File:
®* New job
® Load Master, and
® Load Sample.
® Load from Scanner (Print Inspection Only):
® Scan master,
® Scan Sample, and
® Select Source.

® Clear all inspection results, and
® Return to the main view.
® Forward: Return to the inspection view.

Available Options under each Menu

Back: Retain all inspection results, and return to the main view.
Text Inspection: Text inspection performed when selected.
Graphics Inspection: Graphics inspection performed when selected.

°
L]
°
® Color Inspection: Color inspection performed when selected.
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Broillg Spelling
Inspection Inspection

Barcode

: Profile Settings
Inspection

Available Options under each Menu

Barcode Inspection: Barcode inspection performed when selected.
Braille Inspection: Braille inspection performed when selected.
Spelling Inspection: Spelling inspection performed when selected.

[ ]
°
[ ]
* Profile Settings: Manage inspection profiles for the selected inspection mode (available admin accounts only).

Inspect

Inspect

Available Options under each Menu

Inspect: Run the selected inspection mode.

Report: Generate inspection report(s).

Help: Licensing, give feedback, support, shortcuts, about.

Menu: Resolution (300, 400, 600,800, 1200, Custom), administration (settings, audit trail, user maintenance, reporting levels, comments,
workflows, backup, force review of all differences, force inclusion of all differences) change password, layout, preferences, logout.

# Note: Some of the above buttons are only available in certain stages and not others.

Back: After an inspection is successfully completed
Forward: After clicking ‘Back’

File: Only available pre-inspection

Load From Scanner: Only available pre-inspection
Report: After an inspection is successfully completed



GVD 5.10 Backup Tools (Master & Sample)

Summary

The toolbar at the top of the Master and Sample Panel contains several tools that always remain available regardless of the module selected.
Each of them is covered in detail below.

® Toolbar

® 1. PDF Options
2. File Information Panel
3. Image Adjustment Panel
4. Marquee Zoom
5. Reset View

Toolbar

PDF

1. PDF Options

If a PDF or Al file is loaded in the Master panel, the PDF Options icon can be checked, or unchecked to set it on or off.

2. File Information Panel

To display information about the Master file:
® Click File Information.
The following information becomes available:

File Type: The originating file format.
Rastered DPI: The DPI at which the file was rasterized.
Image Size: The size of the image (in pixels).

L]
L]
L]
® Memory Size: The amount of physical memory the rasterized image uses (in MB).

3. Image Adjustment Panel

To adjust the Master image's brightness, contrast, or gamma value:
® Click Image Adjustments. Click the button in the center of the bar and slide to right or left.
Alternatively,

® Click on the arrows on either end of the fields or manually type-in values for each of them.
® Click Apply to make the changes or click Cancel to close the panel.

4. Marquee Zoom



To magnify the image:

® Place the cursor in the Master panel. Scroll upward with the trackwheel.

#) Note: On a Mac operating system, scroll downward with the trackwheel if the Scroll Direction: Natural setting is ON.
To select an area in the image to magnify:

® Click Marquee Zoom. Select the area using the left button of your mouse.

® Scroll upward with the trackwheel.

) Note: On a Mac operating system, scroll downward with the trackwheel if the Scroll Direction: Natural setting is ON.

To reduce the magnification:

® Place the cursor in the Master panel. Scroll downward with the trackwheel.

) Note: On a Mac operating system, scroll upward with the trackwheel if the Scroll Direction: Natural setting is ON.

To pan:

® Left-click in the Master panel. Hold and move the mouse around the panel.

5. Reset View

NA

W N

To restore the image to its original size:

® Click Reset View



GVD 5.10 Backup Page Selection Toolbar

Summary

The Master/Sample Page Selection toolbar on the bottom of both Master and Sample panels contains the following tools:

® Page Selection Toolbar
® 1. Page Navigation
. Page Selection
. Show Pages
. Reload Page
. Rotate Page
. Save View

e o 0o 0o o
OO~ WN

Page Selection Toolbar

1. Page Navigation

To display a different page in the Master/ Sample panel before or after inspections:
® Click the left or right arrows on either side of the Page Navigation tool.

Alternatively,

® Click on the arrow in the middle of the tool to access the Page Navigation drop-down list and go directly to the page of your choice.

# Note: When performing single-page inspections on multi-page files, this feature is disabled after the inspection is run.

2. Page Selection

® Click the Page Selection icon for the option to include or exclude pages from a multi-page document when running an inspection. This
launches the Select Pages window.
® When clicking the icon in the Master panel, the Select Master Pages window pops up.

® When clicking the icon in the Sample panel, the Select Sample Pages window pops up instead.
To include/ exclude different pages in a master or sample file before running an inspection:
® Click Include or Exclude on the left side of the window.
® Click either All Pages, Even Pages, or Odd Pages, or enter a custom range on the right side.
® Select Apply to Master/ Apply to Sample, depending on the panel in which the Page Selection icon was first clicked, to finalize the

page range.
® Select Copy to Sample/ Copy to Master to apply the same range to the other panel.

) Note: Copy to Sample/ Copy to Master can only be used when the number of pages is the same in the Master and Sample.

To reset the pages and negate your selection:

® Click the Reset Pages icon to the left of the Page Selection icon.

3. Show Pages



The Show Pages/Hide Pages icon shows/hides an extra panel displaying all the pages loaded in the Master or Sample panel.

When the panel is hidden, an up arrow appears. Once the icon has been clicked and the panel appears, displaying the different pages, a down

arrow appears instead.

# Note: The icon is disabled once an inspection is run.

To display a different page in the Master or Sample panel:
® Click on the page of your choice in the Show Pages panel.
To scroll through the loaded pages in the Show Pages panel:

® Move the mouse over the scroll bar at the bottom of the panel.
® Scroll the trackwheel up or down or left-click the mouse and move it in the desired direction.

Alternatively,
® Right-click on the scroll bar and choose between the following options:
To exclude a page from the inspection:

® Right-click on a page in the panel to reveal the Exclude Page option.
® Click it to cross the page out and exclude it from the inspection.

To re-include excluded page(s):
® Right-click a page and unselect the Exclude Page option that appears.
Alternatively,

® Click the Reset Pages icon to reset all pages.

4. Reload Page

To reload the Master:

® Click Reload Page. The image reloads in the Master panel.

5. Rotate Page

1. To rotate the Master 90° clockwise: Click on Rotate then select Rotate 90 CW.
2. To rotate the Master 90° counter-clockwise: Click on Rotate then select Rotate 90 CCW.



3. To rotate the Master 180° clockwise: Click on Rotate then select Rotate 180.
4. To specify the angle to rotate the Master: Click on Rotate then select Arbitrary rotate.

Insert the desired angle by typing in the prompt or clicking the arrows on either side and click OK.

) Note: Not recommended for Text and Spelling Inspection modes.

1. To mirror-rotate the Master horizontally: Click on

Rotate then select Mirror Horizontally.

) Note: Not recommended for Text and Spelling Inspection modes.

1. To mirror-rotate the Master vertically: Click on

Rotate then select Mirror Vertically.

#) Note: Not recommended for Text and Spelling Inspection modes.

9. Save View

L

To save the Master image view:

® Click Save View
® The Save As window displays. Type in the file name and click Save.



GVD 5.10 Backup Document Viewer

Summary

The integrated Document Viewer launches when you load a PDF file.
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® Document Viewer
® 1. PDF Options Panel
2. Layers Panel
3. Separations Panel
4. Layers and Separations Sub-Menu
5. Process Panel

Document Viewer

1. PDF Options Panel

To select an option, click the checkbox beside it or select one of its drop-down options:

l

.,
C g

[=

x




® Enable overprint: Provides an onscreen simulation that approximates how blending and overprinting appear in color-separated output.
The initial default is set to check, while the user's selection acts as the new default for subsequent inspections.

® Following page for region: When a file has multiple pages, you have the option to apply the die line on the next page. This would be
used if the die line is on the next page relative to the artwork (as opposed to the same page, as is the case with some files).

BB *

Options
¥ Enable overprint

PDF Page Bod

Media Box

®* PDF Page Boxes: Select the appropriate page box for shape selection:
® Media Box: Defaults to Media Box.
® Trim Box: Defaults to Trim Box (to be used if your file is print-ready).
® Crop Box: Defaults to Crop Box.

2. Layers Panel

The Layers panel displays a list of the layers present in the PDF file.
To hide a layer:

® Click the eye icon. The icon grays out and the layer becomes hidden in the image.
To unhide a hidden layer:

® Click the eye icon. The icon returns to its default color and the layer re-appears in the image.

Layers
G Registrations
© Guin:ltkn&:
€ MNutrution Fact
> Barcode

3. Separations Panel

The Separations panel displays the color separations present in the PDF file.
To hide a separation:

® Click the eye icon. The icon grays out and the separation becomes hidden in the image.
To unhide a separation:

® Click the eye icon. The icon returns to its default color and the separation re-appears.



Separations
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4. Layers and Separations Sub-Menu

To select a sub-menu option:

® Right-click on a layer or separation to display the sub-menu. Click to select an option:

® Set as shape region & hide: The layer or separation is detected as a shape and hidden when the image is loaded into the
Master/ Sample panel (with the shape outlined).

® Use as shape region: The layer or separation is detected as a shape. The image loads in the Master/ Sample panel with the
shape outlined. The layer or separation is not hidden.

® Add to shape library: The layer or separation by the same name is detected as a shape by default. A yellow folder icon
displays to the left of the selected layer to indicate it has been added to the Library. Right-click to uncheck the Add to shape
library option.

® Hide by default: If you select this option, the selected layer/ separation always stays hidden. The eye icon grays out and a
folder icon displays. Right-click to uncheck the option.

) Note: Only one layer or separation can be used for shape extraction at once. The selected layer or separation is underlined in its
corresponding panel in the integrated Document Viewer.

Layers
€ Registrati~-
{2 Guideline
> Mutrutior
{2 Barcode Add to shape library

® »

Set as shape region & hide k

Use as shape regicn

Hide by default

#) Note: Add to shape library takes effect at the next load. For the shape to be set, reload the file.

£ Note: Hide by default takes effect at the next load, including for the file currently loaded. For the layer or separation to be hidden on the
file currently loaded, reload the file.
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5. Process Panel

The Process panel displays the process colors that are present in the PDF image.
To hide a process color:

® Click the eye icon. The icon grays out and the process color becomes hidden in the image.
To unhide a process color:

® Click the eye icon. The icon returns to its default color and the process color re-appears.
Process
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GVD 5.10 Backup Profile Settings

Summary

This section covers the details of how administrators can add, modify, copy, import, export, delete, and manage a Profile.
® Profile Settings

1. Manage Profiles

. Add a Profile

. Copy a Profile

. Import a Profile

. Export a Profile

Rename a Profile

. Delete a Profile

. Modify a Profile
® 8.1. Via the Profiles Window
® 8.2. Via the Main View
® 8.3.Via Hot Key

ONOUAWN

Profile Settings

1. Manage Profiles

Each of the profiles spanning the different inspection modes, with the exception of Spelling, can be accessed and modified from the Profiles
window.

To load the Profiles window:
® Select the mode to which you would like to add a profile:

. Graphics Inspection
. Color Inspection

. Barcode Inspection
. Braille Inspection

. Text Inspection

O~ wWNPE

& Note: ABraille license is required to add a language to the Braille profile.

) Note: Spelling Inspection dictionaries can only have words added to them via the Main View or hotkey.

® Click the Profile drop-down menu on the main toolbar and select Manage.
Profile

Drigital

Digital

Dagital to Scan
Len

Proof

Scan bo Scan

Manage

® The Profiles window corresponding to the selected mode launches.

G raphics Profiles

Add Import Export Copy Rename

Digital

Digital t




2. Add a Profile

To create a profile from scratch:

® Click Add. The Edit Profile window displays prepopulated (default) values.

 Edit Graphics Profile X f Edit Barcode Profile X
Barcode Profile

Linear Linear Types DataMabrix QR Options
 ISO/IEC 2016 Standard (uncheck for 20

Scan gap hor. (pi ns) Tgnore quiet 2one
Suppart rotation

Scan gap ver. (pixel rows)

Minimum score Support Negativ

Min, Pharma. W (pix Ignore chedksum

Min. Pharma. H (pixels) 2 Indude in Grading: Data Structure

Min. Pharma. Bars Indude in Grading: Quiet Zone

L ty hor. (o Indude in Grading: Narrow Bar

Min. vidnity ver.
SLIACR NS Inciude in Grading: Wide to Narro

Edge Threshold
Fail Grading if BW

Max i {pi
Min. BWR mm)  -0.10

Max. Pharma. H (pi
' Nominal M ments fo

@ Edit Braille Profile. X

f# Edit Text Profile X
lame
Types Languages Templates Advanced
Difference Types
+ Ttalic
~ Bold Font Type
~ Underline Size
~ Subscript/ 5 Min Font P
Line Bre: In

Hyphen

Defaults

® Enter the new profile name in the Profile Name text box.
® For Graphics, Barcode, and Text Inspection modes:
® Update the values as required.

) Note: Digimarc Barcode support is only available as a licensed module. To enable it, check the box that appears beside the feature in
the Barcode Inspection Edit Profile window.

® For Braille Inspection:
® Click Add to make an addition by entering a new dot pattern in the prompt that appears.
® Click Modify after choosing an already created dot pattern to edit your selection. Then make the desired changes in the prompt
that appears.
® Click Delete after selecting an already created dot pattern to delete it from the profile.
® Click Apply. The Profile window displays, featuring the new profile name.



) Note: Spelling Inspection profiles (dictionaries) cannot be added; Information on Color Inspection profiles, which can be added by
regular users, can be found in the User Guide.

3. Copy a Profile

To create a profile based on an existing profile:

® Click on the profile of your choice in the Profiles window and then Copy. Enter the new profile name in the text box that appears and

click on OK.
® The new profile name displays in the Profiles window.

# Note: Spelling Inspection profiles (dictionaries) cannot be copied.

4. Import a Profile

To import a profile:

® Select Import in the Profiles window to load the Open window. Browse for the file to import and click Open. The loaded profile appears
in the Profiles window.

£ Note: Spelling Inspection profiles (dictionaries) cannot be imported.

5. Export a Profile

To export a profile:

® Select the profile to be exported in the Profiles window and click Export. The Save As window displays with <profile name>.ini in the Fil
e name field for Graphics Inspection Mode profiles (or .xml for Barcode, Braille, Color, and Text Inspection modes).
® Select the desired folder location and enter the desired file name. Click Save.

& Note: Spelling Inspection profiles (dictionaries) cannot be exported.

6. Rename a Profile

To rename a profile:

® Select the profile to be renamed in the Profiles window and click Rename.
) Note: Default and Spelling Inspection profiles (dictionaries) cannot be renamed.

® Enter the name in the text box that appears and click on OK. The Profiles window displays with the new profile name listed.

7. Delete a Profile

To delete a profile:

® Select the profile to be deleted in the Profiles window and click Delete.
) Note: Default and Spelling Inspection profiles cannot be deleted.

® The following message displays: “Are you sure you wish to delete the profile [name]?”
® Click Yes to confirm the deletion.

8. Modify a Profile

8.1. Via the Profiles Window



To modify parameter values from the Profiles window:
® Double-click on the profile you would like to change in the loaded Profiles window to display its Edit Profile window. Click Apply to
finalize your changes.

) Note: Default profiles cannot be modified.

8.2. Via the Main View

To modify parameters from the Main View:

® Ensure the profile you would like to edit displays the selected one in the Profile drop-down menu at the top of the screen. Click on the Pr
ofile Settings icon at the top of the Application.

® [fitis not a default profile, you can update the values as required in the Edit Profile window once it loads.

® |f a Spelling Inspection profile (dictionary) is selected, the Edit Spelling Profiles window displays.

® Click Add to create a new entry in the selected dictionary or Modify or Delete to modify or delete a selected entry that has already been
created.

i#® Edit Spelling Profiles x
P 9

Proofing
Ignore UPPERCASE

Ignore = that contain numbers  »F

Spelling Profile Mame

Word List

Add Modify Delete

Edit Spelling Profiles Window

® Click Apply to finalize your changes.

# Note: If aninspection has just been run, it runs again based on the modified parameters.

8.3. Via Hot Key

To modify parameters via hotkey:

Ensure the profile you would like to edit displays the selected one in the Profile drop-down menu at the top of the screen.

Press CTRL + P to launch its Edit Profile window.

If it is not a default profile, you can update the values as required (see Section 4.2.2 Add a Profile).

If a Spelling Inspection profile (dictionary) is selected, the Edit Spelling Profiles window displays.

Click Add to create a new entry in the selected dictionary or Modify or Delete to modify or delete a selected entry that has already been
created.



® Click Apply to finalize your changes.

# Note: If aninspection has just been run, it runs again based on the modified parameters.



GVD 5.10 Backup Application Settings

The menu options contain the following settings:

Preferences
Rezolution
Layout

Administration

Change Password

Logout

. Preferences

. Resolution: Select the DPI value or set a custom value.

Layout

. Administration: (Administrators, Managers, and users with ‘Modify Profile’ access Only)
Change Password

. Logout: Log out from the Application and display the Login window.

oOUAWN R


https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931494309/GVD+5.10+Backup+Preferences
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931494367/GVD+5.10+Backup+Resolution
https://globalvisioninc.atlassian.net/wiki/spaces/~968984517/pages/2931494385/GVD+5.10+Backup+Layout
https://admin.globalvision.co/test/
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1259798612/User+Account#5.-Changing-Password
https://globalvisioninc.atlassian.net/wiki/spaces/HC/pages/1259798612/User+Account#4.-Logging-Out
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User Interface
Scanner Settings
Measurement
Color Profiles
Job Settings
System Paths

User Interface

User Interface

Language English

Hi-Contrast Difference Image

Difference Highlight Color

Mask
Automatically zoom to each difference «*

Raster documents after zoom

® Language: Default is English. GlobalVision also supports Chinese, Czech, French, German, Italian, Japanese, Korean, Polish,
Portuguese (Brazil), Russian, Slovenian, and Spanish.

® Hi-Contrast Difference Image: Displays differences between Master and Sample images in high contrast.

* Difference Highlight Color: If checked, this option highlights Graphics Inspection differences in the mask of customizable color and
size. Re-inspect for the changes to take effect.

® Mask Color: This option lets the user set the mask color, with the ability to pick screen or custom colors.

® Automatically zoom to each difference: If checked, the selected difference, barcode, or Braille region is zoomed in, instead of just
highlighted.

® Raster documents after zoom: If checked, Barcode, Text, or Spelling Inspection files raster automatically to add clarity and less
pixelation.

Scanner Settings
Scanner Settings
Show Scanner interface L

or Library Color Epson D3

® Show Scanner interface: If checked, the application goes through the scanner software while scanning. If un-checked, the scanner
software is not displayed.
® Color Library: Select the preferred color library from the list, based on the connected color-calibrated GlobalVision scanner.

Measurement

Measurement

Default unit mm

® Default unit: Choose your unit in which lines or rectangles shall be drawn using the Measurement Tool.



Color Profiles

Color Profiles

RGB AdobeRGB

RGB Profile: RGB Profile is used to display the color space in the user interface. The default profile is AdobeRBG1998.icc.

CMYK Profile: CMYK Profile is used to display the color space in the user interface. The default profile is USWebCoatedSWOP.icc.
Netlmage Profile: The color calibration file for the connected Nextimage scanner(to be used in conjunction with Color Inspection Mode).
GlobalVision C8 Profile: The color calibration file for the connected GlobalVision C8 scanner (to be used in conjunction with Color
Inspection Mode).

Job Settings

Job Settings

® Show Job Interface: If checked, this option automatically loads the Job Wizard whenever the application is opened, or the interface is
reset.
® Job Master Path: Set default path loaded when selecting master files on the Master & Sample Selection screen of the Job Wizard.

System Paths

Sy=tem Paths

Cadhe Path

Repert Fatf

Image Save Path

Cache Path: Set where data is stored by the application.

Report Path: Set the location of where generated reports are to be saved.

Image Save Path: Set default path while saving images.

Show font substitution notifications: Ability to show or hide the font substitution popup message from the Ul. By default, set to show.
Support rotated repeats: When checked, repeats get detected regardless of the direction they are facing.
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nspect (= OJE

Preferences

|

Imaae De

300 Resolution
ADD Layout
R00 Adrministration

800 Change Password

1200 Logout

Custom...

In order to set the resolution of a master or sample file:

® Click on Menu then Resolution. Choose between the options available (DPI: 300, 400, 600, 800, 1200, or Custom.)
® |f the selected DPI of any file you load is different than the Desired DPI setting in the profile being used. Click Yes to change the DPI to
the suggested amount or No to go ahead with the initial value.

) Note: PDFs are automatically rastered to the set application DPI, hence the Master and Sample files must be set at the same DPI value.
If they do not match, a message will appear when you try to run any inspection.

In order to set a custom value in DPI:

® Click on Menu then select Resolution then Custom.
® Type in your custom value or press the arrows to increase or decrease any value. Click OK.
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® Layout Settings
® Master Panel
® Inspections Panel

Summary
The Inspection View contains panels that let you review the text inspection results. These panels constitute your layout and can be displayed or

hidden as required.

Layout Settings

Layout customization is ideal for multi-monitor configurations, as panels can be placed on separate displays. To view the different layout panels
that can be loaded, click on Menu then Layout.

— X

Inspect E 0 )

Preferences
Image Det

Resolution
La‘_-ﬂut
Administration

Ir'nagn'.: Details Change Password

Inspections Logout

Repeats

Differences

Eraille

Barcodes

Master Panel (Alt + M)

Save Layout

Reset Layout

To display/ hide the panels:

® Uncheck the panel name in the Layout drop-down menu or click on X in the top-right corner of the panel once it has been loaded to hide
it. Check the panel name to display it.

To move a given panel:

® Click on its title bar, hold down, and shift it to one of the empty areas in the margins of your screen.
To save your layout for it to re-appear as is, upon closing and re-opening the Application:

® Click Save Layout.
To reset your layout to the default:

® Click Reset Layout.

Master Panel

Toggling the Master Panel on/off in the Layout drop-down menu shifts the file from appearing in the Sample panel (regardless of whether it is a
master or sample being inspected) to it taking up the entire Inspection View. The latter is the default position



Inspections Panel

The Inspection View contains the Inspections panel, which lists completed inspections. For example, you may run multiple inspections prior to
generating the report. The Application lets you rename the inspections and/or exclude them from the report.

Ife Inspection

Rename Inspection

1 Graphics Single Pa

To rename the inspection:

® Right-click on the inspection name in the Inspections panel. Click Rename.
® Enter the desired name and click OK.
®* The new name displays in the Inspections panel.

To exclude the inspection from the report:

® Right-click on the inspection name in the Inspections panel. Click Exclude from the report.
® The inspection name gets crossed out in the Inspection Panel.
® The inspection is not included in the next generated report.
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1. Account Creation

Once your administrator creates any account, this process generates an email with a subject line.

Auto-Generate Email Example

~ “GlobalVision user account created”
It contains the new user’s Username and temporary password, if SMTP settings have been configured as required. The email also
contains the next steps for how to login and create a new password.

# Note: For more information on creating user accounts, please consult the Administrator Guide.

2. Logging In
® Start by double-click the GlobalVision application shortcut on your desktop.

" Login

GVD

Type in your user name, password and then dick Login

Liser Mame Login

Cancel

Forgot pass:

® Enter your User Name and Password and click Login.

) In case of first-time login or Password Reset, a Temporary password message window displays.

3. First-Time Login

® Enter the temporary password received via email or from your administrator.
® Enter your new password for the New Password field and reenter to Confirm Password.



i Password

Old Password

Mew Password

Confirm Password

Accept  Cancel

® Click Accept and OK on the notification window.

@ GlobalVision ®

Password changed.

4. Logging Out

To logout of the system:

® Click on Menu then Logout. This will save your session and return you back to the Login window.

Or,

® Click the X on the top-right corner of the window to simply exit the application.

) Note: On a Mac® operating system, click X on the top-left corner of the window to exit the Application.



o

Preferences

Resolution

Administration
Change Password

Lo gout

o Exit oo

Exit application?

Yes

5. Changing Password

To change your password:

® Click on Menu then Change Password. The Password window will display for you to create your new password.
® Enter your Old Password and New Password in the respective fields.
® Click Accept and OK on the notification window.
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The following options are available upon clicking the Help icon:

B @ =

F | A

About
Shortcuts
Video Tutonals

Give Feedback

GlobalVision Support

Licensing

Select About for application version details.

. Select Shortcuts for available keyboard shortcuts.

. Select Video Tutorials for how-to videos on specific features.

Select Give Feedback to request any new feature or to report a bug.

. Select GlobalVision Support for GlobalVision Customer Support.

. Select Licensing to view Serial Number and Company Name information.

oUhwWN R
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® Abbreviations

® Glossary

Abbreviations
Ai Adobe lllustrator file format developed by Adobe Systems for representing single-page vector-based drawings
BMP Bitmap (image file format)
CMYK Cyan, Magenta, Yellow, Key color space
DOC/DOCX Microsoft Word Document
FDA Food and Drug Administration
HTML/HTM HTML/HTM Document (Hypertext Markup Language)
ICC International Color Consortium
JPEG/IPG Joint Photographic Expert Group (Image compression method)
LAB L for lightness and a and b for the color dimensions
LEN Bitmap file format (Plate Prep file for remote plate making and for production distribution)
MHT/MHTML MHT/MHTML Document (MIME Hypertext Markup Language)
oS Operating System
PDF Portable Document Format
PNG Portable Network Graphics
QRD Quality Review of Documents
RGB Red, Green, Blue color space
RTF Rich Text Format Document
TIFF Tagged Image File Format
TXT Text File Document
XLS/XLSX Microsoft Excel Document
XML XML Document (Extensible Mark up Language)

Glossary

BARCODE A barcode is an optical machine-readable representation of data.
BRAILLE A writing system using a series of raised dots to be read with the fingers by people whose eyesight is not

BRAILLE CELL

CHANGE DIFFERENCES

CMYK

DELETION
DIFFERENCES

sufficient for reading.

Series of up to six raised dots set out in a domino-type cell

All insertions, smaller than a sentence, where a deletion occurs in the same area of the document (the
previous and following matched up pair is the same in both documents). Any difference that is longer than a
sentence, but otherwise a change, is an insertion/deletion.

The CMYK color model (process color, four color) is a subtractive color model, used

in color printing, and is also used to describe the printing process itself. CMYK refers to the four inks used in
some color printing: cyan, magenta, yellow, and key (black).

Found in the Master but not in the Sample.


http://en.wikipedia.org/wiki/Adobe_Systems
http://en.wikipedia.org/wiki/Vector_graphics

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

DELTA-E

DIFFERENCE

DIGIMARC BARCODE

DOMAIN

AUTHENTICATION

DOT DIAMETER

DOT HEIGHT

ELECTRONIC FILE

EMBOSSED

GLUE DOTS

HARDCOPY

HICKIES

ICC PROFILE

INSERTION

DIFFERENCES

LAB

LOCAL
AUTHENTICATION

LOCATION
DIFFERENCES

MARBURG MEDIUM
SPACING CONVENTION

MASTER

MIXED DIFFERENCES

MODULE

PANTONE

READING ORDER
CORRECTION LEVELS

REPEAT

REPORT

RGB

SAMPLE

SKEW

Delta-E (E) is a single number that represents the 'distance’ between two colors. A color difference of less
than a Delta E of 3 means that the human eye cannot perceive the color difference between two points.

A discrepancy between the Master and the Sample.

A proprietary method for imperceptibly enhancing packaging, images and audio with data that is detected by
enabled devices.

The username, password, and password settings are maintained by Windows XP and later Windows Server
operating systems (Active directory).

Distance from the beginning of the upward dot slope and the end of the downward dot slope.
Distance from the beginning of the dot slope to its uppermost peak.

The soft copy (original artwork).

Raised Braille dots created with the use of a dye press.

Raised Braille dots created by a transparent resinous ultraviolet curing process.

Paper copy.

White spots on the printed page when specks of dirt or bits of paper fiber adhere to the printing plate or
blanket.

A set of data that characterizes a color input or output device, or a color space, according to standards
promulgated by the International Color Consortium (ICC).

Found in the Sample but not in the Master.

The CIELAB color space (also known as CIE L*a*b* or sometimes abbreviated as simply “"Lab" color space)
is a color space defined by the International Commission on Illlumination (CIE). The space itself is a three-
dimensional 3-axis color system with dimension L for lightness and a and b for the color dimensions, allowing
an infinite number of possible representations of colors.

The username, password, and password settings are maintained by the application.

One or more consecutive matching sentences in the Sample where the prior and post text is different than in
the Master ignoring added, deleted or moved sentences.

The defined system of dimensions within and between the Braille cells.

A packaging component that has been approved by a regulatory body. The Master may be an electronic file
or a hardcopy.

Occurs when one word contains more than one type of font difference (e.g. a color change and a size
change). "Mixed" type would also be used when one word contains two or more different font names, two or
more different font sizes, or two or more different font colors.

Graphics, Color, Barcode, Braille, Text and Spelling.

Pantone Inc. is a U.S. corporation best known for its Pantone Matching System (PMS), a proprietary color
space used in a variety of industries, primarily printing, though sometimes in the manufacture of colored

paint, fabric, and plastics.

The system detects differences using the following three reading order correction levels: High, Medium and
Low.

More than one of the same image on an electronic copy and/or hard copy.
Displays inspection results.

A particular RGB color space is defined by the three chromaticities of the red, green, and blue additive
primaries, and can produce any chromaticity that is the triangle defined by those primary colors.

An incoming packaging component that may be an electronic file or a hardcopy.

Angular deviation of the image. Shall be limited to 10%.


https://en.wikipedia.org/wiki/Color_space

35 SPACE DIFFERENCES

36 TVS64 APPLICATION

37 ELECTRONIC
SIGNATURE

The space difference is a change due to an actual space inserted between characters vs. no space. The new-
line differences are also identified as space difference where text after hyphen is moved to the next line.

Proofreading solution that inspects: Graphics, Barcode, Braille, Text and Spelling.

A computer data compilation of any symbol or series of symbols executed, adopted, or authorized by an
individual to be the legally binding equivalent of the individual’s handwritten signature.
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